## Table of Contents

### Getting Started
- System Requirements ................................................................. 5
- Contact Information ................................................................. 5
- Login ......................................................................................... 6
- Terms of Service ......................................................................... 6
- System Check ........................................................................... 6
- Import from Previous Year .......................................................... 7
- Overall Site Navigation .............................................................. 8

### Home
- Yearbook Tasks .......................................................................... 9
- My Tasks ................................................................................... 10
- My Profile .................................................................................. 10
- Student Frequency Report ......................................................... 11
- Video Tutorials & FAQ’s ............................................................. 11
- Community Upload ................................................................. 11
- Yearbook Page Status Report .................................................. 12
- Shortcuts .................................................................................. 13
- Facebook Preview .................................................................... 13
- Kit Materials .............................................................................. 16
- Help .......................................................................................... 17
  - Reference Documents ............................................................ 18
  - Contact Us .............................................................................. 18
  - FAQ’s & Video Tutorials .......................................................... 18

### Set-Up
- Manage Users ........................................................................... 19
- Invite User ................................................................................ 19
- Assigning Site Features & Page Access ..................................... 19
- Usage History .......................................................................... 19
- Book Settings ........................................................................... 21
- Color & Deadline Assignment .................................................. 21
  - Select Spot Color (Volumes ONLY) .......................................... 22
- Portraits .................................................................................... 23
- Page Themes ............................................................................. 23
- Borders & Backgrounds ............................................................ 23
- Fonts ......................................................................................... 24
- Styles ........................................................................................ 25
- Custom Dictionary ................................................................... 28
- Site Preferences ......................................................................... 29
- System Import .......................................................................... 29
### ORGANIZE: PLAN

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Book</td>
<td>31</td>
</tr>
<tr>
<td>Cover &amp; Endsheets WebEase</td>
<td>32</td>
</tr>
<tr>
<td>Cover &amp; Endsheets Volumes</td>
<td>34</td>
</tr>
<tr>
<td>Upload Custom Cover Designs</td>
<td>35</td>
</tr>
<tr>
<td>Proof Covers</td>
<td>36</td>
</tr>
<tr>
<td>Ladder</td>
<td>37</td>
</tr>
<tr>
<td>Submit to Lifetouch</td>
<td>38</td>
</tr>
<tr>
<td>Approve a Page</td>
<td>38</td>
</tr>
<tr>
<td>Master Pages</td>
<td>39</td>
</tr>
<tr>
<td>Supplement Builder</td>
<td>40</td>
</tr>
<tr>
<td>View Proofs</td>
<td>40</td>
</tr>
<tr>
<td>Yearbook Preview</td>
<td>40</td>
</tr>
<tr>
<td>Organize Pages: Swap/Copy/Move</td>
<td>41</td>
</tr>
</tbody>
</table>

### ORGANIZE: LIBRARIES

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image Management</td>
<td>43</td>
</tr>
<tr>
<td>Upload Images</td>
<td>43</td>
</tr>
<tr>
<td>Image Libraries</td>
<td>46</td>
</tr>
<tr>
<td>Create New Folder</td>
<td>48</td>
</tr>
<tr>
<td>Rename Folder</td>
<td>48</td>
</tr>
<tr>
<td>Delete Folder</td>
<td>48</td>
</tr>
<tr>
<td>Image Usage</td>
<td>49</td>
</tr>
<tr>
<td>Search</td>
<td>49</td>
</tr>
<tr>
<td>Community Library</td>
<td>49</td>
</tr>
<tr>
<td>Portrait Library</td>
<td>50</td>
</tr>
<tr>
<td>Portrait Page Wizard</td>
<td>52</td>
</tr>
<tr>
<td>Portrait Flow Guidelines</td>
<td>53</td>
</tr>
<tr>
<td>Export Portraits</td>
<td>56</td>
</tr>
<tr>
<td>Add Sort</td>
<td>56</td>
</tr>
<tr>
<td>Search Portraits</td>
<td>56</td>
</tr>
<tr>
<td>Re-sort</td>
<td>57</td>
</tr>
<tr>
<td>Add Name</td>
<td>57</td>
</tr>
<tr>
<td>Borders/Backgrounds/Clip Art</td>
<td>57</td>
</tr>
<tr>
<td>Template Library</td>
<td>58</td>
</tr>
<tr>
<td>Create Custom Templates</td>
<td>58</td>
</tr>
<tr>
<td>Snip-it Library</td>
<td>58</td>
</tr>
<tr>
<td>Index Editor</td>
<td>59</td>
</tr>
</tbody>
</table>
**TABLE OF CONTENTS**

**BUILD**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Icons &amp; Control Palettes</td>
<td>61</td>
</tr>
<tr>
<td>Action Icons</td>
<td>62</td>
</tr>
<tr>
<td>Menus</td>
<td>63</td>
</tr>
<tr>
<td>Apply Templates</td>
<td>65</td>
</tr>
<tr>
<td>Create Custom Portrait Templates</td>
<td>67</td>
</tr>
<tr>
<td>Edit Portraits on Flown Pages</td>
<td>67</td>
</tr>
<tr>
<td>Images</td>
<td>68</td>
</tr>
<tr>
<td>Adding Images to Page</td>
<td>68</td>
</tr>
<tr>
<td>Image Details</td>
<td>69</td>
</tr>
<tr>
<td>Applying Backgrounds and Borders</td>
<td>70</td>
</tr>
<tr>
<td>Text</td>
<td>71</td>
</tr>
<tr>
<td>Font</td>
<td>71</td>
</tr>
<tr>
<td>Color &amp; Effects</td>
<td>72</td>
</tr>
<tr>
<td>Spacing &amp; Alignment</td>
<td>73</td>
</tr>
<tr>
<td>Text Wrap</td>
<td>74</td>
</tr>
<tr>
<td>Special Characters</td>
<td>74</td>
</tr>
<tr>
<td>Add Elements</td>
<td>75</td>
</tr>
<tr>
<td>Add Snip-it</td>
<td>76</td>
</tr>
<tr>
<td>Text-on-a-Path</td>
<td>77</td>
</tr>
<tr>
<td>Properties</td>
<td>78</td>
</tr>
<tr>
<td>Image Effects</td>
<td>78</td>
</tr>
<tr>
<td>Shape</td>
<td>78</td>
</tr>
<tr>
<td>Fill</td>
<td>79</td>
</tr>
<tr>
<td>Border</td>
<td>80</td>
</tr>
<tr>
<td>Drop Shadow</td>
<td>81</td>
</tr>
<tr>
<td>Size &amp; Position</td>
<td>81</td>
</tr>
<tr>
<td>YB Parking Lot</td>
<td>82</td>
</tr>
</tbody>
</table>

**SALES TRACKER & FINAL SUBMISSION**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales Tracker/YBPay</td>
<td>83</td>
</tr>
<tr>
<td>Final Quantity Submission</td>
<td>86</td>
</tr>
</tbody>
</table>

**RESOURCES**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Troubleshooting</td>
<td>87</td>
</tr>
<tr>
<td>Glossary</td>
<td>93</td>
</tr>
</tbody>
</table>

**INDEX**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>96</td>
</tr>
</tbody>
</table>

*Information in this document is subject to change without notice. Complying with all applicable copyright laws is the responsibility of the user. No part of this document may be reproduced or transmitted in any form or by any means, electronic or mechanical, for any purpose, without the express written permission of Lifetouch National School Studios Inc. © 2015. All rights reserved. Adobe is a registered trademark of Adobe Systems Incorporated in the United States.*
Welcome to Lifetouch Yearbooks online!
This guide was designed for both WebEase and Volumes users. As you read through the guide, you will see specific features identified that may be specific to the WebEase or the Volumes program.

### SYSTEM REQUIREMENTS

#### Operating Systems

<table>
<thead>
<tr>
<th>Windows</th>
<th>Apple Mac OS</th>
</tr>
</thead>
<tbody>
<tr>
<td>XP</td>
<td>10.5 (Leopard)</td>
</tr>
<tr>
<td>Vista</td>
<td>10.6 (Snow Leopard)</td>
</tr>
<tr>
<td>V.7</td>
<td>10.7 (Lion)</td>
</tr>
<tr>
<td>V.8</td>
<td>10.8 (Mountain Lion)</td>
</tr>
</tbody>
</table>

#### Browsers

<table>
<thead>
<tr>
<th>Type</th>
<th>Main Site</th>
<th>Image Editor</th>
<th>Ad Builder*</th>
<th>Sales Tracker</th>
<th>YB Pay</th>
<th>Community Upload</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chrome</td>
<td>v.26 to latest</td>
<td>v.26 to latest</td>
<td>v.26 to latest</td>
<td>v.26 to latest</td>
<td>v.26 to latest</td>
<td>v.26 to latest</td>
</tr>
<tr>
<td>Internet Explorer</td>
<td>v.8</td>
<td>v.11</td>
<td>v.10+</td>
<td>v.11</td>
<td>v.11</td>
<td>v.11</td>
</tr>
<tr>
<td></td>
<td>v.9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>v.10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>v.11</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Safari</td>
<td>v7+</td>
<td>v7+</td>
<td>v7+</td>
<td>v7+</td>
<td>v7+</td>
<td>v7+</td>
</tr>
</tbody>
</table>

*Available for Volumes only

#### Additional Software

- Adobe Macromedia Flash (version 11 and above)
- Adobe Acrobat Reader (version 9 or above)

#### Screen Resolution

- Minimum 1024 X 768 or above (1280 x 1024 resolution recommended)

### CONTACT INFORMATION

**WebEase Customer Care**  
Phone: 1.800.736.4761  
Email: WebEaseCustomerCare@lifetouch.com

**Volumes Customer Care**  
Phone: 1.800.736.4762  
Email: VolumesCustomerCare@lifetouch.com
GETTING STARTED

LOGIN

Step 1: Login

Once enrolled, you will receive an email that invites you to work on your yearbook. If you do not already have a Lifetouch password, instructions will be provided on how to create one.

With that information, go to http://onlineyearbooks.lifetouch.com to access the Online Yearbooks website.

When you login for the first time, you will be asked to go through a few initial set-up steps, then you will be directed to the Home page.

TERMS OF SERVICE

You will be asked to accept the terms of service information on the use of the Online Yearbooks website and the Internet.

SYSTEM CHECK

Step 2: Run the Online System Check

Requirements that are NOT yet met by your system will be marked with a red “X.” You can learn how to fix the problem by clicking “Details.”

If you need help, you can contact your school/district technology representative or Lifetouch Customer Care.
Step 3: Import Items From Previous Year

System Import allows yearbook advisers to import various information from their prior year’s book.

– Custom Styles
– Book Settings
  • Color and Deadline Assignment
  • Border and Background Default
  • Font Settings
  • Portrait Settings
  • Custom Dictionary
  • Site Preferences
– Custom Templates
– Users
– Image Library Names
– Ladder Diagram Page Descriptions
– Ladder Diagram Page Templates

System Import is only available for renewed schools.
OVERALL SITE NAVIGATION

**Home:** The Home Page gives you an overview of your progress, and the tools to help you easily complete your yearbook project. Features include:
- Contract Details
- Yearbook Deadlines
- Yearbook Page Status Report
- View My Pages
- My Profile
- Yearbook Shortcut Links

**Set-Up:** Allows you to manage your yearbook staff and complete Book Settings for consistency throughout the book.

**FYI: CUSTOMIZE YOUR SITE**

You can customize your website to display only the features that you or your staff members will use. Under Set-up, go to Book Settings > Site Preferences.

**Organize:** Allows you to plan your content and organize your libraries.

**Build:** Navigate to your page and start building.

**Sales Tracker:** Monitor and record yearbook sales, activate YBPay, and submit your final quantities here.
Home gives an overview of your progress, plus tools to help you manage your yearbook project.

**Yearbook Tasks** includes two sections to help you understand your yearbook progress:
- **A: Work to Complete**
- **B: Completed Work**

**Sections include:**
- Page Deadlines
- Cover and Endsheet Deadline
- Final Quantity Deadline (yearbooks and enhancements)
- Name List Deadline
- Cover Proof Deadline
- Endsheet Proof Deadline
- Page Proof Deadlines
  Indicates for user to watch for page, cover or endsheet proofs if applicable.

**Status Icons:**
- Orange Alerts – user must approve a page or cover proof.
- Red Clock – section is overdue
- Yellow Clock – section is due within 1-14 business days.
- Green Clock – section is on track and deadline is not approaching within the next two weeks.
- Blue Check – section is complete.
MY TASKS

You control the content that appears in the My Tasks. You can create a task for yourself or a task assignment for another individual.

STUDENT FREQUENCY REPORT

The Student Frequency Report helps you manage the number of times a student appears in your book. This calculation looks for portrait names from the Portrait Library and locates them throughout the pages. It looks for these names in the following location:
- Portrait Names that are flowed onto pages
- Names that appear in text boxes
- Names tagged on image in the Image Library and placed on pages

Since the site is scanning multiple areas of the site for this report, you may need to wait a few seconds for it to generate.

VIDEO TUTORIALS & FAQ'S

Video Tutorials & FAQ's are tools you can use to find information on a variety of topics.
The **Community Upload** site allows members of a school’s community to upload images for consideration in the yearbook. A school specific access code (available on the Online Yearbook Home Page) is required for the community members to register at community.lifetouch.com. After a user logs in, instructions on how to upload are provided on the site.

Users with Adviser or Sales Rep status will have access to the Community Upload Library in the Online Yearbooks site (can be assigned to other staff members).

Informational page is available to describe the process.

Adviser needs to set up folders that will appear on the community upload site (under Libraries > Community Library).
COMMUNITY UPLOAD

The community library will hold up to 10% of the maximum number of images allowed in an account.

For example, if a school is allowed 1200 images, the community site will allow for 120 images.

Once the limit is reached, community users will no longer be able to upload images until the adviser cleans out the community library by:
• Moving images into the Image Libraries
• Deleting images

Adviser will receive the following emails:
• Notification that the site has reached capacity.
• Weekly email that indicates how many images are in the community library.
• Community Upload URL: community.lifetouch.com

Image Requirements:
• JPEG format, 10 mb or less.
• Only thumbnail images available.
• User cannot retrieve the original image they uploaded into the site (only yearbook staff can).

YEARBOOK PAGE STATUS REPORT

The Yearbook Page Status Report gives the status of your yearbook pages in a visual bar chart. You can use “View My Pages” to virtually flip through your saved pages.
Yearbook Shortcuts give you quick access to:
- Download User Guide
- Ladder Diagram
- Image Library
- Image Upload
- Portrait Library
- Build Pages
- eLearning Modules
- Facebook Preview App

Generate excitement about your yearbook by featuring it on your yearbook page on Facebook.

Click Facebook App in the Yearbook Shortcuts section.

Select the page you would like the Yearbook Preview to appear on and click Add Page Tab.

NOTE:
The Facebook Preview can only be added to a company, organization or institution page on Facebook that you have administrator access to. It cannot be added to a personal Facebook page.
Go to your page on Facebook by selecting **Account > Use Facebook as Page**.

Once there, click on **YB Preview**.

Click **Set Up Yearbook Preview**.
Select a page range and a Preview End Date. Customize the Promotional Message with your personal info and click Create Preview.

**TIP:**
- Only 32 pages may be displayed at a time, separate pages using a comma, and indicate a range using a dash (for example, 1,5,10-14).

When users click the Yb Preview tab on your site, they will be able to see a preview of the pages you selected.
FACEBOOK PREVIEW

You may make changes to the pages you want to show, or your promotional message after your Preview has been created. Click Setup Yearbook Preview.

To delete your Yearbook Preview, click Edit Info at the top of Your Page, click Apps on the left hand side and delete the Yearbook Preview app.

ONLINE KIT MATERIALS

KIT MATERIALS
Access Yearbook Kit Materials and additional resources 24/7 online following these simple steps:
1. Click on the Kit Materials link at the top of the screen
2. View and download PDF documents
3. Save to your computer or print

You may request printed copies. Please consider the environment before ordering.

Important Note:
Schools will not receive a yearbook kit automatically.
**My Profile** is a summary of the details that are unique to you, including:
- Email
- First Name
- Last Name
- Password

This is also the area where you can change these details.

**Help** gives you access to FAQ’s, video tutorials, and more.

**REFERENCE DOCUMENTS**

**Resources** is where you can find downloadable versions of materials including this User Guide, Headline and Body Copy Samplers, and Software Download Info.
CONTACT LIFETOUCH
This section makes it easy to send a message to Lifetouch, yearbook staff members or anyone with a valid email address.

FAQ’S & VIDEO TUTORIAL
FAQ’s and Video Tutorials cover a wide variety of helpful topics.
The Manage Users section is where advisers can give other people permission to work on the yearbook.

INVITE USER
Advisers can Add Users by providing an email address or click "This new user does not have an email account."

There are 6 user types: Adviser, Editor, Staff Member, Photographer, Student and Volunteer.

Advisers will have access to all website sections.

ASSIGNING SITE FEATURES & PAGE ACCESS
Advisers can assign site features to staff members by selecting or deselecting the Site Features options. Advisers can also allow or restrict users’ access to specific pages.

By default, Editors, Staff Members, Photographers, Students and Volunteers will not have access to the following areas of the site:

1. Book Settings
2. Sales Tracker & Resources
3. Manage Users
4. Plan – Organize Pages
5. Custom Dictionary
MANAGE USERS

VIEW USAGE HISTORY

View Usage History shows the frequency and duration of users’ activity within a specific month. History for each month will be available as long as the account is active.
**Book Settings** lets you select default preferences to maintain consistency and save time. Pick defaults for portraits, fonts, styles, backgrounds and more. Book Settings is also where your Color & Deadline Assignment page is located.

The important defaults below are set only if the system import was not used for these sections. You may edit these defaults.

**Default Portrait Settings:**
- Name Order: First, Last
- Student Names: Times New Roman
- Teacher Names: Times New Roman
- No Photo Option: No Photo Clipart

**Default Color/Deadline Assignment:**
- Sets the first sigs to be on the first deadlines, up to the number of pages needed for 1st deadline.
- Sets the first sigs to be color, up to the number of color pages contracted.

**Color & Deadline Assignment** is where you can pick which pages will be in color, if your contract includes color pages. You must assign the color before you can start creating pages.

**HOW TO: ASSIGN COLOR PAGES**
1. Review your contract details to find out how many color pages you can have.
2. Pick your color pages by selecting the check boxes for a flat (8 pages) or the entire signature (16 pages).
3. Save your color assignments by clicking “Save.”

**FYI: COLOR ASSIGNMENT DETAILS**
- You cannot make changes to the color assignment of a signature after one or more of its pages have been submitted.

**FYI: ASSIGN DEADLINES**
- WebEase users must assign deadlines to each signature (they will either be in the 1st or 2nd deadline) before creating pages.
Spot Color
If your contract includes spot colors, you must select and assign your spot colors before you can start creating pages.

HOW TO: SELECT SPOT COLORS
1. Begin the process by clicking “Select Spot Color.”
2. Add a Spot Color by clicking “Add Spot,” which will open a new window.
3. Choose your color(s), then click “Add Color.”
4. Click “Close” to return to the Assign Color window.

HOW TO: ASSIGN SPOT COLORS
1. Select a flat or signature you want to have spot color(s).
2. Select 1 or 2 spot colors from the drop-down menu.
3. Double click on Select Spot Color box. Highlight the color to use and click Select Color.
4. Repeat steps 1-3 according to the details of your contract.
5. Click “Save” to complete the process.
Your Portraits settings will determine how people’s names will be formatted on your portrait pages. This is also where you would select your preference for individuals with no portraits.

**HOW TO:**

**SELECT PORTRAIT DETAILS**

1. **Pick your preferred Name Display** by selecting “First Last” or “Last, First.”
2. **Choose a font** for the names. If you want to use the bold version of that font, click “B.”
3. **Select your preferred “No Photo” artwork** that will be displayed for students who don’t have a photo. If you want these students to be listed together under the portrait names, select the “Not Pictured List” option.
4. **Click “Save”** to complete the process.

**Page Themes**

Page Themes will allow WebEase users to select a specific collection of coordinating creative options (e.g., cover, border, background and clipart). Once selected, these options will be easily accessible in the Build section.

Setting defaults for page **Borders and Backgrounds** will help you save time and increase consistency throughout your book. The Volumes yearbook program does not include borders.

The border and background you pick here will automatically be included on every page, but you can make changes when you are creating a page in Page Creation>Build.

**Solid Color Backgrounds:** Apply any solid color background to pages using the color picker above the Lifetouch backgrounds. You may tint these backgrounds in 10% increments.

**Solid Color Borders:** To change the color of a 1-color border, select the border in the list of options and then use the color picker above the Lifetouch backgrounds to change it.
Your **Fonts** settings will establish the set of font options available throughout your book.

**HOW TO: SELECT YOUR FONTS**

1. **Review the existing yearbook fonts** already available for use by viewing the “Fonts Available in Yearbook” window.
2. **Select additional fonts** by clicking “Add Additional Fonts.”
3. **Highlight the fonts** (see FYI below) you want, and click “Add Fonts.”
4. **Define your default fonts** for headlines, sub-headlines, body copy and captions using the drop-down menu, then click “Save.”

**FYI: FONT SELECTIONS**

You can **select multiple fonts at one time** by holding down the Control button on your keyboard (or Command for Mac users) while scrolling down the list and clicking on the font(s) you want.

Avoid slow site performance by only adding the fonts you know you will use. Adding more than 10 fonts can slow down the process to create pages.

The **default fonts you select** here will determine the fonts that will be automatically used when you first start working on a page, but you can manually change the fonts as you create pages.
A style is a set of attributes for a specific type of text. It includes things like font, size, color, leading, kerning, tracking, alignment and tint.

There are two types of styles:
1. **Styles provided by Lifetouch** are automatically included in all Lifetouch templates and flow into the template when selected.
2. **Custom Styles** are styles that you create yourself. You can either modify one of the styles and save it with a new name, or you can create a style from scratch.

**HOW TO: VIEW AND EDIT STYLES PROVIDED BY LIFETOUCH**

1. Review the list of styles provided by Lifetouch and click the one you want to view or edit.
2. View or change the style attributes on the resulting screen.
3. Complete the process by clicking “Save as Custom Style.” Your edited style will be saved and updated in the Styles Provided by Lifetouch list.
**SET-UP**

**STYLES**

**HOW TO:**

**CREATE A CUSTOM STYLE**

1. **Name the new style** by entering it in the name field.
2. **Pick the attributes** you want the style to have.
3. **Complete the process** by clicking “Save as Custom Style.” Your new style will be saved and added to the Custom Styles list.

**FYI: TYPOGRAPHY RECOMMENDATIONS**

- **Use styles consistently.** For example, all headlines should use the same style, and the style used for headlines shouldn’t be used for anything else.
- **Don’t use too many different fonts.** Often the most appealing and easy-to-read publications only use three or four fonts.
- **Make sure your text is readable** against your background color.

**FYI: HEADLINES**

- **Headlines should summarize the story and entice the readers.** A primary headline should grab the reader’s attention, and a secondary headline should summarize the story.
- **The headline style should match the tone of the document.**
- **Headline fonts should be consistent throughout the book.**
- **Headlines often look best** when you use a sans-serif or decorative font.
- **Create visual distinction.** If your headline font is the same as your body copy font, make sure the headline is larger and/or bold to set it apart from the body copy.
- **Try not to center your headlines.** Use ragged-right or fully justified text.
FYI: BODY COPY

- Capitalization and styles should be consistent throughout the body copy.
- There should only be one major copy block per page.
- Use sidebars or secondary stories to add visual interest to the rest of the page.
- Include captions with all photos. Captions should be no more than two to three sentences, and often look best in 9-point type.

FYI: ATTRIBUTE DEFINITIONS

- **Style Name** is the name you give a Custom Style or the pre-defined name for a Style Provided by Lifetouch.
- **Font Name** displays the name of the font.
- **Font Size** displays the size of the font in points.
- **Font Style** lists the available styles for a font, such as bold, italic, underline or drop cap. Drop cap inserts a larger letter as the first letter of a paragraph. The size of the drop cap is determined by the number of lines you want it to occupy. (Not all styles are available for all fonts.)
- **Color** determines the color of the text. To decide which color you want, see the colors in the Color Sampler in your kit.
- **Leading** lets you increase or decrease the space between lines.
- **Kerning** adjusts the space between pairs of letters to create a visually pleasant configuration. Kerning is strictly proportional, so the space gets bigger or smaller relative to the character’s point size. Kerning is most effective when used with 18-point text or larger.
- **Tracking** determines the amount of space between letters and words.
- **Alignment** determines placement of the text. You can: Align Left, Align Center, Align Right, Justify and Full Justify.
- **Tint** is the percentage of color the text will be printed in. The default is 100% (darkest) but you can make the color lighter by decreasing the percentage. Keep in mind that text on a background should be at least 60% to be readable.

Use the space below to write down the styles you would like to use in your book. This may be helpful when building pages.
A Custom Dictionary can make the spell checking process more efficient.

Many yearbooks contain words with unique spellings, like mascot names or school slang. Also, most first and last names aren’t typically included in a standard dictionary.

After importing names and unique words, they will no longer be flagged as misspelled when spell checks are run, so you can find the real errors a lot faster.

Once your Portraits have been uploaded and you have reviewed and made corrections to the student names in the Portrait Library, you can upload those names to the Custom Dictionary from the Portrait Library area. Portrait Names will have a green background behind them in the dictionary. Those names may not be deleted from the Custom Dictionary.

**HOW TO:**

**IMPORT YOUR NAME LIST**

1. Create a new spreadsheet (you can use any spreadsheet application you choose) and use the top row to label the columns. The first column must be “LASTNAME”, and the second column must be “FIRSTNAME.”

2. Enter all the names under the appropriate columns.

3. Save the file in CSV format by selecting “Save As” in the File menu of your spreadsheet, then pick “Save as Type: CSV (Comma Delimited) (*.csv).”

4. Import the file by clicking “Browse” on the Custom Dictionary page. Locate your file, then click “Import.”
Site Preferences is where you define how you want to view and create your pages, and other aspects of how you’d like to use the site.

- Indicate if you would like to view and build pages in single or double page spreads.
- Indicate your preferred Units of Measure: Picas or Inches
- Indicate if you would like to show page trim marks: Yes or No
- Set up the website as a favorite or as a shortcut on your desktop.
- Choose if you want to turn off the auto-zoom feature for text boxes
- Under Site Features, customize your site to only show areas that will be used during the yearbook process. This area is viewable by Advisers only. WebEase will have Index and Master Pages turned off by default.

System Import allows yearbook advisers to import various information from their prior year’s book.

- Custom Styles
- Book Settings
  - Color and Deadline Assignment
  - Border and Background Default
  - Font Settings
  - Portrait Settings
  - Custom Dictionary
  - Site Preferences
- Custom Templates
- Users
- Image Library Names
- Ladder Diagram Page Descriptions
- Ladder Diagram Page Templates

System Import is only available for renewed schools.
The Plan tab includes two main areas:

A View Book
B Organize Pages

The View Book area is where you can:
- Plan the details of your cover and endsheets
- Create and edit your Ladder Diagram and access the Portrait Page Wizard
- Create Master Pages
- View proofs
- Preview the whole yearbook
- Review, submit and approve (if applicable) pages to Lifetouch
COVER & ENDSHEETS

WebEase Cover & Endsheets
If using the WebEase program, the cover and endsheet wizards will walk you through the options you have for the cover and endsheets of your book. To request Creative Services, click the Additional Features link.

FYI: WEBEASE COVERS AND OPTIONS

- Your Publication Agreement determines your cover options. The “$” symbol means that the option has an additional charge.
- Two proof options are available for Original Design and Custom Montage. Your options are: PDF or hard copy color cover.
- You must mail or upload your custom artwork to Lifetouch to satisfy your cover deadline.
- Original Design Covers must be selected online and the artwork mailed or uploaded to Lifetouch. More instructions are provided in your Covers Book and on page 36.

FYI: WEBEASE ENDSHEETS

- You must complete the Endsheet Wizard if your book includes a hard cover.
- You can select designs for each endsheet category. You can either select different designs for the front and back of your book, or you can select the same design for both.
- You can’t change your endsheets after they have been submitted, but you can view them online.
FYI: REVIEW COVERS BOOK

You can refer to the Covers Book (in the kit materials section) to see examples and learn about various covers and enhancement options, such as:

- Signature Designs
- Original Designs
- Montage Designs
- Cover Enhancements
- Endsheet Options
COVER & ENDSHEETS

Volumes Covers & Endsheets
If using the Volumes program the Cover & Endsheets control palette lets you:

- Upload custom cover designs.
- Review uploaded cover proofs.
- Submit final Creative Services requests to Lifetouch.

FYI: CREATING & SUBMITTING COVER ARTWORK

- **Designing Covers:** Covers often look best when designed with vivid colors and high contrast. If the cover art is supposed to fill the entire cover (full bleed), make sure there is enough background surrounding the design so no white is showing around the edges. This is very important for large photos and backgrounds that use patterns or gradient blends.
- **Photo Collages:** If your cover includes photo collages, don’t build up layers of overlapping photos.
- **Original Artwork:** Avoid using light crayon or colored pencil drawings for original artwork because they don’t scan well and much of the image might be lost. Avoid feathered or gradient artwork. Submit computer-generated line art whenever possible.
- **Software:** When the cover design is created in software programs like Adobe Illustrator or Adobe InDesign, be sure to submit the artwork with all links (clip art, photos, etc.) and fonts used to build the cover design.
- **Resolution:** The resolution must be at least 600 dpi. Always submit a printout of the electronic cover design.

Once you submit your cover and endsheets to Lifetouch, we will create and upload the proofs to your account.

A thumbnail-sized image of your cover and endsheets (if applicable) will be displayed.

Clicking on the proof icon will display a PDF version of your cover and endsheet proof. You can view, save, print or email the PDF proof. See page 36 on how to handle proofs.
HOW TO: UPLOAD CUSTOM/ ORIGINAL COVER DESIGNS
1. Go to Plan > Cover and Endsheets.
2. Click Upload Your Custom Cover Artwork.
3. Browse for your file and upload it.
   - File name length should not exceed 25 characters.
   - Name your file using characters and/or numbers.
   - You can upload one file at a time.

FYI: UPLOADING CUSTOM/ ORIGINAL COVER DESIGNS
The file should not exceed 50 MB. Do not use *, &, ′, or other special characters when naming the file. Enter a description to explain specific instructions for your cover.

If you have selected a cover design or endsheets that require custom artwork, you may upload the custom artwork here. The following cover and endsheet designs may include custom artwork:
- Original Design Cover
- Montage Original Design Cover
- Original Design Endsheet

Follow these guidelines:
- The length of the file name should not exceed 25 characters.
- Name your file using characters and/or numbers.
- You can upload one file at a time.
- If you have more than one file to upload, please zip your files together using a file zipping software such as WinZip or 7-Zip.
- The file size should not exceed 50 MB.
- Do not use *, &, ′, or other special characters when naming file.
HOW TO: APPROVE A PDF PROOF

1. Review the PDF proofs of your cover and endsheets within 48 hours of the posting. You will receive an email notification that your proof is available. Locate your proof under Organize > Plan > Cover & Endsheets.

2. Make note of any desired changes in Creative Services area and submit. Keep in mind that extensive revisions might cost more. You should talk with your Lifetouch Yearbook Representative if you have revisions or questions.

3. Select “Approve” if you have no additional changes on your cover and endsheets. Otherwise, describe your desired changes and submit them back to Lifetouch.

PROOF COVERS

FYI: UPLOADING CUSTOM/ORIGINAL COVER DESIGNS

Be sure your artwork submissions:
- Contain all document files.
- Contain high resolution image files.
- Contain all fonts used in creation of the artwork.
- Are unflattened and contain all layers and elements placed on those layers.

The following resolutions are required:
- Line Art - 500 DPI (dots per inch).
- Grayscale - 225 DPI (dots per inch).
- Color - 300 DPI (dots per inch).
- We recommend that artwork is submitted in CMYK to ensure accurate color reproduction.
- Acceptable file types include .eps, .psd, .ai or .tiff file format.
- Images to be reproduced in spot color should be labeled with PMS number.

The following software files are acceptable:
- Adobe Photoshop (version 4.0 and higher).
- Adobe Illustrator (version 6.0 and higher).
- Adobe InDesign (all versions accepted).

Note: Microsoft PowerPoint, Word or Publisher files will not be accepted. For additional information on how to submit your custom artwork, review our Original Design Cover Guidelines.
The **Ladder** helps you get an overview of your book. You can view pages in either “Diagram” or “List” view.

**A**

**The “Diagram View”** gives you a visual representation of each page spread, along with the page details.

**B**

**The “List View”** shows your pages in a sequential list.

You can edit your page information quickly in the “Edit All” view. You can also sort your pages by their current status to see the progress of each page. You can view up to 100 pages at a time. When using the “Search” or “Show All” features the site will only search the pages that are displayed on your Ladder at that time.

In both views, the color of the thumbnail box indicates the page status:
- **Red**: Not Started
- **Yellow**: In Progress
- **Orange**: Submitted to Adviser
- **Green**: Submitted to Lifetouch
- **Blue**: Lifetouch needs Adviser Approval

Editors will have access to submit pages to the Adviser to review. To do this, the Editor should click the “Submit to Adviser” button on the Ladder Diagram for any pages that are ready to review. Once the adviser reviews the page, it can be either submitted to Lifetouch, or put back into the “In Progress” status. The adviser’s “What to Do Now” section will indicate when a page has been submitted to the adviser.

Only Advisers will have access to Submit to Lifetouch.

**HOW TO: SELECT TEMPLATES IN THE LADDER**

1. Select the “Ladder” control palette.
2. Select the page(s) you want to work on by entering a page number or a range of pages.
3. Specify the Page Details by clicking “Edit Details” and providing a description of the page, page type, and more.
4. Select a template by scrolling down the template list using the up and down arrows. Once selected, a thumbnail of the template will appear. Repeat this step to choose another template.
5. Assign a Master Page style, if applicable.
6. Click “Save Changes” to complete the process.
When you are ready to submit a page to Lifetouch, you must review your PDF proof very carefully. Once you have reviewed your PDF proof, click “Submit to Lifetouch.”

Note: If you would like additional changes made to your page that you are not able to complete yourself, indicate your instructions in the “Request Creative Services” area under the Page Actions drop-down in the BUILD tab.

FYI: SUBMITTING PAGES

- When you are about to submit the last 5% of your pages, you will be prompted to submit your Final Quantity if you have not already done so.
- All pages that include portraits from the exact same sort must be submitted at one time. (e.g., if the portraits from Mrs. Johnson’s 6th Grade are featured on pages 6 and 7, both pages must be submitted at the same time).
- All Index pages must be submitted at one time.

If you requested Creative Services for any pages, you will receive an electronic proof of each page before it is printed. An email will be sent to the yearbook adviser when Lifetouch has uploaded the proof for review. Locate the proof (a PDF icon) on the Ladder. Click the PDF icon to open the proof. You must approve the changes you requested within 2 business days, or it will be auto-approved by Lifetouch.
Use Master Pages to create a consistent page design either for your entire book, or by section. You can include elements like folio art, text, sidebars and more.

HOW TO: CREATE A MASTER PAGE
1. Name your Master Page by selecting “Edit Details” in the Master Page control palette.
2. Double click on the thumbnail to activate the page creation workspace.
3. Create the Master Page using the various tools and page elements available in the Control Palettes. (Reference pages 63-76)
4. Select “Save” to complete the process.

FYI: MASTER PAGES
• Creating Master Pages: You can create up to 16 Master Page spreads. Master pages can also be built and saved in the Build tab.
• Applying Master Pages: After you have created your Master Pages, you can apply them to the pages in the Ladder. When a Master Page is applied to a page, the template inherits the master page elements.
• Locking and unlocking Master Pages: You can unlock master page elements when building pages by selecting the element and then selecting “Lock/Unlock” from the Element Actions menu.
• Viewing Master Page elements: When a template is open in the Build tab, Master elements can be identified by selecting “Highlight > Master Page Elements” under Page Actions.
• Disabling Master Pages: If you don’t want to use Master Pages in your yearbook, this feature can be disabled in Site Preferences under the Book Settings section.

FYI: FOLIO TEXT/GRAPHICS
• Contrast: Make sure the folio text/graphics on the Master Pages don’t blend in with the page backgrounds.
• Dark colors: If your school’s folio text/graphic is a dark color, it’s not going to be visible against a dark background. To fix the problem you can either make a local change to the Master Page and change the folio text/graphic to white or another light color, or you can create separate Master Pages—one with black text/artwork and one with white text/artwork.
SUPPLEMENTS

If contracted for a supplement, a Supplements control palette will appear in the Organize > Supplement Section. Once a user clicks on this control palette, the website will display the contracted supplement pages. Click on any of the supplement pages to begin building. Building a supplement page is very similar to building regular yearbook pages. The following functions are not available on supplement pages:

• Portrait templates & flowing will be disabled.
• Swap, copy and move functions will be disabled.
• Page numbers will not be included on the pages, however, you may add them manually to each page.
• Names that appear in the supplement will not be included in the book’s index.
• Master page elements will not be applied to supplement pages.
• Once all supplement pages are built and saved, a “Submit to Lifetouch” button will appear on the top of the supplement section and in the section left of your first supplement page. All pages must be submitted at one time. You may include special instructions for your supplement if you wish. Our plant will upload new proofs to your online yearbooks site if needed and they will be auto-approved by Lifetouch.

VIEW PROOFS

To View Proofs, you can enter the range of pages you want (maximum of 100) and click View PDF. After the PDF is generated, you can view, save or print it.

YEARBOOK PREVIEW

The Yearbook Preview control palette lets you page through your book two pages at a time or as a slide show. You can click “Next” to preview each page consecutively. (Keep in mind that these previews are updated nightly, and will not reflect the changes you make until the next day.)
Clicking on the Organize Pages icon lets you:

- **Swap** the location of two pages.
- **Copy** the text and layout of one page onto a new page.
- **Move** the elements from one page to another.

**FYI: ORGANIZE PAGES**

- **You can use this feature** for pages that are not started (red border), or pages in progress (yellow border).
- **Before your action occurs**, you will see a pop-up message to confirm what is about to happen.
- **If you change your mind** about the change you just made, you can’t click the “undo” icon, but you can make the same action in the reverse direction.

**SWAP**

**Swap** lets you exchange the location of two pages.

- **Double-page mode** must be used if a page spread includes cross-gutter elements.
- **You can’t swap pages** after you flow the portraits or index.

**COPY**

**Copy** lets you create a duplicate of an existing page. You can copy in either single-page or double-page mode.

- **In single-page mode**, if you copy an odd page to an even page, the elements will maintain their existing position on the page.
- **Double-page mode** must be used if a page spread includes cross-gutter elements.

**MOVE**

The **Move** feature enables you to change the location of a double-page spread within a 10-page range.

- **Moving a page** will cause the pages after it to shift.
- **You can’t move pages** after you flow the portraits or index.
NOTES:
The **Libraries** tab helps you keep your photos, graphics, templates and index names organized. The four icons within this tab include:

- **Image Management**
- **Template Libraries**
- **Snip-It Libraries**
- **Index Editor**

**Image Management** helps you organize your photos and other graphics into three categories:
- **Image Library** contains all of your candid and activity photos.
- **Community Library** is where images from the community is uploaded to before being move into Image Libraries.
- **Portrait Library** is where the student and staff portraits are uploaded from Lifetouch.
- **Borders/Backgrounds/Clip Art** includes

There are two ways to upload images into the site:

- **You can upload your own images**, which is usually the fastest and easiest way to start working with your own photos.
- **You can mail a CD or prints** to Lifetouch. We will upload off the CD, or scan your prints for you.

**Uploading your own images**

The **upload images** function enables you to load your own digital files directly into the site. You can upload 50 images at a time. We recommend that you only upload images that you intend to use, or delete those images that you do not plan on using. Once uploaded, the images can be included in the library you choose. You may also drag and drop images into new folders.
**HOW TO: UPLOAD IMAGES**

1. Click the “Upload” button to get started.
2. Indicate which folder you would like your images uploaded into.
3. Browse and select the images you want to upload. Your images will be placed into a list, called a queue, until you are ready to upload them. You can select multiple images by holding down Shift or Ctrl while clicking on the files. Choose up to 50 images to place into your queue at one time.
4. Click “Upload Images” to complete the process. If you need to upload more images right away, click “Browse” and select additional photos.

**FYI: CANDID IMAGE CAPACITY**

The total number of candid images allowed in your Image Library is a calculation based on the total number of pages in your book. Multiply the total number of pages by 15 to achieve the maximum number of candid images allowed. (e.g., a 96-page book is allowed 1440 images (15 images x 96 pages).

When uploading images with a transparent background, the online yearbooks website will preserve the transparent background. The transparent files can be uploaded in either a .tif, .eps or .png format.

Note: Once the image is put on a page in the “Build” section, fading edge, ghosting or indicating a background fill will remove the transparency. Keep in mind the transparent image will need to be created using an outside program like Photoshop. When saving a .tif file using one of those programs, it normally flattens the file and puts a white background behind it. Be sure to choose the option to save as a layered tif file to preserve the transparency.
Mailing images to Lifetouch:
You have the option to mail your activity photos and clip art (prints or on CD) to Lifetouch where they will be professionally scanned and placed in your Image Libraries. For WebEase, use the Activity Page Stickers and the Image Library Envelope. Volumes account use the Photo Library Information Card and the Photo Bag. To order additional materials, go to the Kit Materials tab in the upper right corner of the site.

**FYI: PREPARING IMAGES FOR UPLOAD**

- **Make sure your images are high resolution.** Only upload high-resolution images, but make sure they aren’t more than 10MB per image. You won’t need to upload low-resolution images because the site will create them for you.
- **Save your files in the most appropriate format.** Photos work best in .tif or .jpg format, and line art should be in .eps format. For .jpg images, use the highest quality and lowest compression settings available.
- **Use the camera zoom carefully.** Use only the optical zoom on your digital camera (instead of the digital zoom).
- **Name your images with “keyword” information** to help you sort them once they are uploaded. Our system will rename the uploaded images using the sequential job number and “-CU”, which stands for “Customer Upload.” Your original file name will be captured in the keyword search area in the Image Library.
- **Images that have an image size between 400-800 kb will typically fit in a 4 x 6 inch photo box.** If you plan to use larger images, be sure the size is higher. All images should have at least 300 dpi.

**FYI: TIPS FOR SUBMITTING PRINTS**

- **Review your images carefully.** Make sure none of your images have poor quality (e.g. poor color, fuzzy or distorted images), and check for duplicates. You should only send the prints you intend to use in the book. This saves needless scanning and allows your images to be uploaded faster.
- **Create consistent Image Library names.** For example, if your current library is titled Ninth Grade, write “Ninth Grade” on all of your items. Do not use variations of the library name (e.g. 9th, Grade 9, Freshmen).
- **Don’t use paper clips or manila envelopes with metal clasps.** The clasps can scratch photos.
- **Send items on a regular basis as they become available to you.** You don’t have to wait until you have a large quantity of items before you mail them to Lifetouch. Frequent submissions allow for faster uploads which gives you access to images sooner.
IMAGE LIBRARIES

Image Libraries help you keep your photos organized. In the Image Library control palette you can:

- **Create as many Image Libraries as you like.** You can be as broad or specific as you want to be.
- **Create sub-folders** under main folders to keep related groups of images together. You need a top level folder before you can create sub-folders.
- **Access the montage page designs** that you may have sent to the plant to be uploaded.

**HOW TO: VIEW PHOTOS**

1. **Click on an Image Library name** to view image details.
2. **Browse the library to find an image.** Below the image, you’ll see the name of the image and the page number(s) it has been placed on, if any.

This zoom bar will allow you to enlarge the images in your library screen.
**FYI: IMAGE DETAILS**

The image detail screen includes:

- **Image Name:** The name created by our system when the image is uploaded.
- **Submitted By:** The name of the person who uploaded the image.
- **Appears on Page:** If the image appears on a page, it will be indicated here.
- **Maximum Print Size:** Displays the largest size the image can be displayed in before the quality of the image is impacted.
- **Photographer:** Enter the photographer’s name here in case you need to contact that person with questions about the photo.
- **Keyword:** Enter the words you would use to search for this photo when creating your pages.
- **Rating:** Indicate how much you like the image, or how strongly you feel about the photo being used in the book, by giving the photo between one and five stars.
- **Name for Index:** List the names of the people in photos so they will appear in the Index. Each time the image is placed on a page, the names in this field will be flagged for the Index.
- **Image Library:** Lets you move an image from its current Image Library to a different Image Library.
- **Rotate** your image 90° left, 90° right, flip image horizontally or vertically.
- **At the bottom of the Image Details screen** you will see an **Image Well**. You can navigate to a different image in that sort by clicking on the thumbnail of that image in the Image Well.

If you enter “Names for Index” on an image, when that image is placed on a page, the names entered for index will appear in the Index Wizard.

**HOW TO: ENTER NAMES FOR INDEX**

1. **Double click on Image Name** and the Image Details screen will open.
2. **Click on Enter Names** in Name for Index line.
3. **The Enter Names to Index screen will open.** Type in the names of all people in the selected image.
4. **Click Save.**
5. **Click Save Changes in Image Detail screen.**
**IMAGE LIBRARY - CREATE NEW FOLDER**

New Image Library folders and sub-folders are easy to create. Start by clicking “New Folder,” select a location. If you want your folder to be a main folder, select Top Level. If you want it to be a sub-folder, select the Library Name you want it under. Enter a name and click Create.

**IMAGE LIBRARY - RENAME FOLDER**

Folders and sub-folders can be renamed at any time. Just click “Rename Folder,” select the folder you want to rename from the drop-down menu, and enter a new name for it. Click Rename.

**IMAGE LIBRARY - DELETE FOLDER**

Folders can be deleted by clicking “Delete Folder” and selecting the folder you would like to delete. Library folders can only be deleted if they are empty. Click Delete.
Image Usage gives you an overview of the images used on each page. Each library will also show the usage under each image.

You can search for an image in several ways:
- **Keywords**: Search with the keywords that you entered in the Image Detail screen.
- **Usage**: Search by “used” or “not used”.
- **Folder**: Search within a specific Image Library folder.
- **Rating**: Search by the rating (number of stars) entered in the Image Detail screen.

The Community Library holds the images uploaded by community members. See page 11-12 for details.
The Portrait Library contains all of your individual portrait images. The portraits will be placed into folders organized by teacher, grade or homeroom.

In this section, you can:
- View your portraits
- Re-sort your portraits
- Flow and un-flow your portraits

**FYI: PORTRAIT DETAILS**

When you click on a portrait name, you will see these details:
- **Image Name** is the name Lifetouch gives your photo when the image is uploaded.
- **First Name** is "first name" that was attached to the portrait on picture day.
- **Last Name** is the "last name" that was attached to the portrait on picture day.
- **Name will appear as** shows how the portrait name will appear in the book ("First Last" or "Last, First"). You can change this in the Portraits area of the Book Settings section.
- **Title** is where you can enter the title of a faculty or staff member.
- **Faculty and Staff check box** indicates a faculty or staff member portrait. (This will tell the system to flow their portraits in front of the student portraits in the sort.)
- **Image Placement** lets you determine the order of appearance when there is more than one faculty or staff member in a sort.
- **Sort Value** lets you list a grade, homeroom or teacher ID for each portrait.
- **Appears on Page** indicates whether the image appears on any pages.
- **Uncheck the Use Portrait Image box** for any images you do not want included in the yearbook.

**FYI: OPTIONS FOR CHANGING PORTRAIT IMAGES**

If you need to change a portrait image, you can:
- Replace an existing portrait with an image from the Image Library.
- Replace an existing portrait with "No Photo" artwork.
- Replace "No Photo" artwork with an image from the Image Library.
- Revert back to the original portrait you had for a person if you’ve already changed it once.
FYI: PORTRAIT LIBRARY DETAILS

Sort ID: The label associated with the sorts when they were uploaded by the plant or created by you.

Description: The information you add to help identify who is in the sort.

# of Images: The quantity of images in the sort.

Zoom: The tool that lets you enlarge or reduce the portrait image in the box. “No zoom” will keep the portrait as it is. The option you pick will affect all the images in the sort (see image at right).

Status: The details about the status of the sort, such as not enough pages to flow, or if the sort is already flown.

Action: Indicates the action that is available for the sort, such as flow, un-flow or select pages.

Print: A quick way to load a printer-friendly version of the images according to your sort.

Delete: Lets you delete the sort.

Export Portrait Names to Custom Dictionary: Allows you to send all portrait names to the Custom Dictionary so they don’t appear as misspelled words.

TIP:

• Managing your portrait library is very important to make it easy to flow portraits onto your pages. Check the spelling, make sure portraits are in the proper sort and indicate if the portrait should be used or not.

• If multiple sorts appear per grade, consolidate the sorts into one portrait library. When the extra sorts are empty, delete them.
PORTRAIT PAGE WIZARD

Portrait Page Wizard:
• Allows user to:
  – Determine how many pages are needed for a sort based on a particular template
  OR
  – Determine what template options are available for a sort based on the number of pages and a headsize
• Located under:
  – Plan > Ladder
  – Libraries > Portrait Library

HOW TO: USE THE PORTRAIT PAGE WIZARD

STEP 1: Select Template
• Indicate your sort. Sorts will only be available if:
  – They are not assigned to any pages yet
  – Select a Template
  – Site displays how many pages are needed.
  OR
  Select Number of Pages and Headsize
  • Select the number of pages you want for the sort.
  • Select the headsize you want for the sort.
  • Click on the portrait templates you would like to use (must be a mirrored double page spread).

STEP 2: Select Pages
• Select which page(s) you would like the sort to be on. Pages will only be available for:
  – Pages that do not already have a sort
  – Non-Index pages
  – Non-Submitted pages
• If you select pages that were already in progress, the content of those pages will be replaced with the new portrait template.
• Indicate if you want to:
  – Assign Templates and Flow Portraits Now
  – Assign Templates Now and Flow Portraits Later (choose later if you want to edit the portrait boxes in Build prior to flowing).
• Select Finish
HOW TO: FLOWING PORTRAITS

STEP 1:
Review and Proof Portrait Information
- Go to Organize > Libraries and click on Portrait Library
- Click on a sort ID to view its portraits
- Click the Edit All button to edit the portrait names and the “Use This Image” indication
- Correct any misspellings by typing in the name boxes
- Indicate if the picture should be used in the book by checking the “Use Portrait Image” box
- Repeat this process until you have reviewed the entire sort
- Click “Save All” to save your edits
- To copy a portrait to another sort, click on the portrait and hold the control key down while dragging the portrait to another sort
- To move a portrait to another sort, click on the portrait and drag it to its new sort
How to: Flowing Portraits Continued

Step 2:
Assign Pages & Flow: 3 Options

Option 1:
In Build
**Recommended Process**
1. Select a page for a particular sort
2. Open the Template Selection area in the left column
3. Search for a template and drag it to your page
4. Use the sort drop-down menu under Page Flow Actions to indicate which sort you would like assigned to the page
5. Save the page
6. Repeat this process for all portrait pages
7. Click the “Save and Flow” button to see how many portraits in a sort still need to be assigned to a page

Once you have assigned enough pages for a sort, you will be prompted to flow the sort. Be sure to review any names that are identified as being duplicates. If the information looks accurate, check the box to enable the flow and then click the “Flow This Sort” button.

Option 2:
In Organize > Plan
In Individual Page Mode
1. Go to the Ladder Diagram
2. Navigate to the page(s) you want to work on
3. Specify the page details by clicking “Edit Details,” including page type, headsize, template and sort value
4. Click “Save Changes”
5. Repeat this process for all of your portrait pages

If you have assigned enough pages for a sort when you click the “Save Changes” button, you will be prompted to flow the sort. Be sure to review any names that are identified as being duplicates. If the information looks accurate, check the box to enable the flow and then click the “Flow This Sort” button.
HOW TO: FLOWING PORTRAITS CONTINUED

OPTION 3:
In Organize>Plan
In Edit All Mode
1. Go to the Ladder Diagram
2. Navigate to the page(s) you want to work on
3. Click the “Edit All” button and specify the page details, including page type, headsize, template and sort value
4. Click “Save Changes”
5. Repeat this process for all of your portrait pages

If you have assigned enough pages for a sort when you click the “Save Changes” button, you will be prompted to flow the sort. Be sure to review any names that are identified as being duplicates. If the information looks accurate, check the box to enable the flow and then click the “Flow This Sort” button.

Alternate Flow Option
If you choose not to flow your portraits when prompted to do so, you may flow them at a later time within the Portrait Library.

In Organize>Libraries
1. Select the Portrait Library
2. Locate the sort value that you would like to flow
3. Under the Action column, click the Flow link.
4. Read the message in the pop-up window and then click the flow button
The Export Portraits tool lets you download your Portrait images and names to a zip file. Just click “Export Portrait Information” to begin the download.

The Add Sort link is where you add a Sort Name, Description and Sort Type. Click Save.

You can search for names by entering part or all of a name and selecting a sort. Click Go.
You can **re-sort** your portrait images by grade, teacher or homeroom. If you have already flowed your portraits, this function will clear your portraits from the page(s) on which they appear.

![](image1)

**Add New Sort Value**

**Search for Names**

**Portrait Page Wizard**

View Sort By:

- **Grade**
- **Teacher**
- **Homeroom**
- **Select page**

Sort ID:

- 009
- 010
- 011
- 012
- STA

You can **add a new name** while you are in a sort by clicking “Add New Name,” which takes you to the portrait details screen.

![](image2)

**Borders/Backgrounds/Clip Art**

The **Borders/Backgrounds/Clip Art** area lets you view page graphic options provided by Lifetouch. This area also includes folios, which are small graphic elements designed to be placed near the page number.

![](image3)
The Template Library is where you can access the templates you created, along with template options provided by Lifetouch. If you check “Add to Favorites” under the template thumbnail you can easily find it by searching for “favorites” while creating pages. Reference page 68 for details.

Activity templates are listed by category to help you easily find what you need. Portrait templates are listed by headsize.

Custom templates are created by clicking “Create Template” and entering a name, type and template it should be based on. When creating custom templates, you can add elements, change the shape of existing elements or remove existing elements.

FYI: CREATING CUSTOM PORTRAIT TEMPLATES

- You may base your template design on an existing template or design your own. To design your own:
  - Give your template a name and then select “Blank Portrait” under Type
  - Site will ask the user for a headsize and name placement
  - Site will place one portrait box on the page.
  - You can then add rows and columns from the Properties tab
  - You can un-check portrait boxes that you don’t want to appear on the page.
- The properties of the portrait boxes are editable. You can change the border, shape and size/position of the portrait box.
- You can add and edit other page elements such as images, text boxes, shapes and lines. After adding elements, you may edit the shape, fill, border, drop shadow and size/position of those elements.
- When you are ready to use your custom template for a page, select a page number then select the template from your custom template library.

- Snip-Its are a group of elements that allow for additional content on a page.
- Use them as designed or ungroup them to add your own customization.
- Create your own Snip-Its in the Page Builder. See page 75.
The Index section allows you to generate an index for your book:

**STEP 1:**
Identify which pages you want your index on by selecting them in the Ladder. Under Page Type, select “Index.” If you select too many pages for your Index, you will have the opportunity to change the page type before you flow the index.

**STEP 2:**
Generate Index List – once you have completed your yearbook pages, generate a list of names for the index. This list will capture names from text boxes based on:
- Portrait Image Names
- Names that have been entered for index in the image library

The system will also display names that appear to be student names based on two or more consecutive words with capital letters. These names will not be defaulted to flow into the index, however, you can add them or merge them with other found names in the index list.

If names are missing, use the “Add Name” feature to add them.
**INDEX EDITOR**

**Combine Names:**
If one person has various spellings of their name throughout the yearbook, you can combine the names into one record.

**Split Names:**
If there is more than one person with the exact same name, you can split the records so that each person has their own record listed separately.

**STEP 3:**
Flow/Unflow - After your index list has been generated, walk through the steps to flow it onto pages.

View Edit Index Pages - after your index flows into your book, you can view and edit the names on the Index pages. Changes you make to names directly on the pages will not be saved if you decide to unflow the index.
The Build tab is where your pages come to life. You can select templates, insert elements, enter text, apply styles, adjust element properties and more.

In the Build section, the main part of the page is called the “workspace.” Above and to the left of the workspace is where you will find the page creation tools located within Control Palettes, Icons and Menus.

**FYI: PAGE ICONS & CONTROL PALETTES**

The Build tab contains a set of powerful Control Palettes. The Control Palettes provide the tools needed to create yearbook pages.

1. **Template:** View and select the template you want to start from, and view key details about the page.
2. **Image:** Get quick access to the photos and artwork in your libraries.
3. **Text:** Control text attributes including: style, font, size, color and more.
4. **Add Elements:** Add images, text boxes, shapes and lines.
5. **Properties:** Edit the shape, fill, border, drop shadow and size/position.
6. **YB Parking Lot:** Displays extra page elements that remain after an activity template is changed. Drag & drop elements from the parking lot to page. Also, drag & drop image, text, shape and Text-on-a-Path elements from the page into Parking Lot. Items will remain in Parking Lot until you leave the page.
FYI: ACTION ICONS

The top of the workspace includes icons that give you one-click access to useful actions.
1. **Save**: The “Save” icon allows you to save the current page.
2. **Revert to Save**: Revert to last saved version of the page.
3. **Save as a Custom Template**: Save the current page as a custom template to be used again.
4. **Cut, Copy and Paste**: These icons enable you to complete the actions in one click.
5. **Undo and Redo**: If you change your mind as you are working, you can “undo” the last several actions made on the page. After you undo one or more actions, you can “redo” those same actions.
6. **Spell Check**: This icon initiates the spell check process.
7. **Zoom In and Zoom Out**: Allows you to make the page bigger or smaller in size. The more you zoom in, the bigger the elements are. Zooming out will bring more of the page into the workspace.
Several menus are available at the top of the workspace. These menus make it easy to make page actions, and adjust the way the page looks on the screen.

**FYI: “PAGE ACTIONS” MENU**

The Page Actions menu allows you to complete many important activities related to the page you are working on. This menu includes:

- **Save:** Saves the work you have done on a single or double-page spread. It’s good to get in the habit of clicking this menu item (or the “Save” icon) every few minutes.
- **Save As Custom Template:** Saves the current page as a template, which makes it easy to create a similar template on a different page.
- **Clear Contents:** All text and photos within page elements will be deleted from the page. The template, elements and any locked elements, will remain.
- **Clear Template & Contents:** All text and photos, page elements AND the template will be deleted from the page. If you want to change the template on a page that is already in progress, you have to start by taking this action. After the template is cleared, you will be able to select a new one in the Template Selection Control Palette in the Template tab.
- **Columns:** You can add up to eight non-printable column guides which will help you keep page elements in alignment.
- **Revert to Saved:** This action returns the page to the way it looked the last time you saved it.
- **View as Left Page Only:** The workspace will only show the left side of the page spread.
- **View as Right Page Only:** The workspace will only show the right side of the page spread.
- **Highlight:** You can highlight the Master Page Elements or Spot Color Elements or incomplete page elements, so you can easily see where those elements are located on the page.
- **Spell Check:** This will initiate the Spell Check process so you can make sure that all of the words on the page are spelled correctly.
**FYI: “ELEMENT ACTIONS” MENU**

- **Clear Contents:** The content that is contained within the selected element will be deleted, but the element will remain.
- **Delete:** The selected element will be deleted from the page.
- **Order:** You can change the layer of the selected element by bringing it in front or behind other overlapping elements.
- **Align:** You can select multiple elements, and use this function to make them line up in a particular way.
- **Lock/Unlock:** The selected element(s) will toggle between “locked” and “unlocked” status.
- **Group/Ungroup:** Multiple elements can be grouped together, and groups can be divided back into separate elements.
- **Save as Custom Snip-It:** The selected page elements will be saved as a Custom Snip-It.

**FYI: “PAGE ACTIONS” MENU**

- **Find/Replace:** This will open the Find and Replace window which allows you to search the page for specific text and replace it with something else.
- **Request Creative Services:** If you have any special requests for Lifetouch to do something special when they print this page, you can add a note here.
- **Mirror Page:** This action duplicates all of the elements of one side of the page spread, and places them on the opposite side of the page spread in the reverse location.
- **Apply Template Flip:** This action duplicates all elements on a page and flips them into reverse location on the same page.
- **Guides and Grid:** Show or hide guides and grid lines.
- **Snap:** This action turns snap on or off. The snap action causes images or element to line up perfectly to guides and grid lines.
To get started creating pages, the first thing you must do is **Apply Templates**. After a template has been applied to a page, you’ll have access to all of the powerful page editing tools you need to create the page.

### HOW TO: SELECT A PAGE TEMPLATE

1. **Go to a blank page** in your book.
2. **Click the Template icon** in the left column if it isn’t already open.
3. **Define the template type** you are looking for. First, decide if this is an Activity Page or a Portrait Page. Then enter some or all of the available search options (position, library personality, etc.). WebEase customers must search for either right or left templates by using the L or R icons.
4. **Click the “View Templates” button** to have the system search for the options that match the selections you made in the search menus.
5. **Browse the available templates** by scrolling down the left column.
6. **Select a template and drag it onto the page**. This will apply the template to the page and you can view the details at full size.
7. **Save the page** to complete the process.

### HOW TO: CHANGE A PAGE TEMPLATE

If you want to **change the template** on a page that already has a template, follow these steps.

1. **Go to the page** that you want to change.
2. **Follow steps 3-7 from How To: Select a Page Template** above.
3. **When changing an activity template**, you will not lose your content. The images in the largest images boxes will move into the largest boxes on new template and will maintain their properties. The largest text moves to text box with the largest style on new template and it takes the properties (e.g., size, font) of the text box where it lands. The following elements will remain on the page as they were originally placed:
   - Locked or grouped elements
   - Shape elements
   - Text-on-a-Path Elements (if applicable)
   - Manually placed images
   There is an option to undo the action. This function is only available for activity pages. The YB Parking Lot displays what is left over from the change template action.
4. **When changing a portrait template**, you need to first clear the page.
ASSIGN PORTRAIT SORTS TO PAGES

HOW TO: ASSIGN PORTRAIT SORTS TO PAGES
Use the sort drop-down menu under “Page Flow Actions” to indicate which sort you would like assigned to the page. Repeat this process for all portrait pages. Click the “Save and Flow” button when you are ready to flow your portraits. Selecting this button will also inform you if you have too many or too few pages assigned to the sort.

IMPORTANT:
Page Elements that you do not want trimmed off need to be placed at least 1/8 inch from the page trim line.

FYI: USING PAGE TEMPLATES

- **Custom Templates:** If you have a page template that you want to duplicate in other places in the book, you can “Save as Custom Template” by clicking the icon or selecting that option in the Page Actions menu.
- **Favorite Templates:** If there are certain templates you use frequently in the book, you might find it helpful to mark them as “Favorites” in the Template Library. After a template has been marked as a favorite, you will be able to quickly find it in the Favorites category.
- **Template ID numbers:** Each template has a unique ID number. If you know the number of the template you are looking for, you can enter the number in the search options to go directly to it.
- **Left and Right Page Templates:** Some templates are designed specifically for the left or right side of the page spread. If a left page template is selected for the right side of the page spread (or vice versa), the system won’t let you apply the template. You’ll have to search for a template that is designed for the side you are building.
- **Copying a Template:** For instructions on how to copy a template to a new page, see page 41.
CREATE CUSTOM PORTRAIT TEMPLATES

To Create Custom Portrait Pages:
- Select “Create Your Own Portrait Template”
- Select a headsize and name location
- Site will place one portrait box on the page
- User can add rows and columns to the portrait panel from the Properties tab

EDITING PORTRAITS ON FLOWN PORTRAIT PAGES

- If you need to update the spelling of names once the portraits appear on the page, click into the name box and make the edits. When you click out of the name box, the site will ask if you want to save your edits to Portrait Library. It’s a good idea to save your changes to the Portrait Library in case you need to flow the sort on a different page. Also, saving your changes will update the Sales Tracker and the Index.
- If someone was missing on picture day, you can add the person to a flown portrait panel. To do this, click the “Edit Portraits” button at the bottom of the page builder. You will have the option to copy a record from another sort or to find an image from an Image Library.

Save to Portrait Library

Would you like to save your edits to your Portrait Library?
Why save changes to your Portrait Library?
- Reprinting will recognize your changes
- Sales Tracker and Index (if you have one) will include your changes
To save changes later, edit the name box again.

If edits change your alphabetical order, save edits and reflow your sort.

To edit and save
1. Select the name(s) you want to change in library
2. Verify new name and edit as needed
3. Click “Next” button
PAGE DETAILS

The Page Details include several items to help you stay aware of important information:

FYI: PAGE DETAILS

- **Type**: Displays the type of page it is (Activity, Portrait, Custom Activity, Custom Portrait, Index or Blank)
- **Template**: Displays the name of the template.
- **Master Page**: Indicates which Master Page has been applied to the page, if any.
- **Color**: Shows if the page is black & white or full color, according to the Color Assignment settings. Volumes users might also have the option of spot color.
- **Status**: Shows the page’s current status (Not Started, In Progress, Submitted to Adviser, Submitted to Lifetouch, In Production or Needs Adviser Approval).
- **Proof**: Provides a link to a proof of the page, if one is available.
- **Assigned To**: Displays the name(s) of individuals assigned to the page.

IMAGES

After you have assigned a template to a page, you will be able to place images onto the page.

HOW TO: PLACE IMAGES ON A PAGE

1. Go to the page you want to work on.
2. Click the Images icon in the left column, if it isn’t already open.
3. Browse your Image Library by selecting the category of image you want (Images, Portraits, Borders/Backgrounds/Clip Art), then “view all” or browse through the sub-libraries and image thumbnails.
4. Find the image you want by scrolling through the thumbnail images.
5. Drag image directly from library to page. If you drop the image on the page without an image box, the image size will be the same as source image. Image aspect ratio will be retained.
6. Repeat these steps until you have finished placing images.
7. Save the page to complete the process.
HOW TO: RESIZE & MOVE IMAGES

1. Double-click the image box to go into “edit mode.”
2. Make your desired adjustments to the image’s size and location:
   • Use the scroll bar on your mouse to zoom in or out of the image.
   • Click the Properties icon and use the Resize function under Image Effects.
   • Double-click on the image and use the Zoom In / Zoom Out scroll bar above the image.
3. Click off the image box to exit “edit mode.” If the result isn’t quite right yet, repeat steps 1-3 until you have achieved the image size and position you want.
4. Save the page to complete the process.

FYI: PLACED IMAGES

• Image usage details: After you save a page with images, the site will automatically update the image library area to show that the image has been placed on that page.
• If an image is too small: If your image is too small for the image box that you are placing it in, you will receive a warning that the quality of the image will be affected. If you see this warning, we recommend that you make the image box smaller or use a different image.
• If an image is enlarged too much: If your image has been resized to the point of being enlarged too much, you will receive a warning that the quality of the image will be affected. If you see this warning, we recommend that you make the image smaller within the box, or use a different image.

Image details are available for each image after it is placed on the page. The Image Details control palette shows the file name, maximum print size, usage, library and keywords.
APPLYING BACKGROUNDS AND BORDERS

Backgrounds can be applied to your pages to fill the whole page with an image or pattern that page elements can be placed on top of. WebEase users can also apply page borders.

**HOW TO: APPLY LIFETOUCH BACKGROUNDS & BORDERS**

1. Go to the page you want to work on.
2. Click the Images icon in the left column, if it isn't already open.
3. Open the Backgrounds/Borders Library and select the background or border you would like to use.
4. Click “Apply Background” or “Apply Border” to place the design on the page. If you change your mind about the selected image, click “Remove Background” or “Remove Border” button to remove the design from the page, then select a different design.
5. Save the page to complete the process.

**HOW TO: APPLY SOLID COLOR BACKGROUNDS**

1. Go to the page that you want to work on.
2. Click the Images icon in the left column, if it isn’t already open.
3. Expand the Borders/Backgrounds/Clip art control palette.
4. Select “Backgrounds”, then “Backgrounds - Color”.
5. Expand the “Solid Background Color” option and select a color:
   - Select one of the Lifetouch pre-defined colors.
   - *Select any color in the color palette by clicking on the shade that you want. Use the arrow on color bar to change color.
   - *If you have a specific color, you can enter in the RGB value.
   - *Use the eye dropper to select any color from a photo to apply as your background.
5. *Tip: Click the sign in the upper right hand corner to add your color to the “My Color” library to use again.
6. Select Apply background to: Left, Right, or Left and Right.
7. Click “Go” to apply.
The **Text** icon allows you to add and change the text elements on the page.

**HOW TO: INSERT TEXT**

1. **Go to the page** you want to work on.
2. **Click the Text icon** in the left column, if it isn’t already open.
3. **Click the text box** you want to work with. Double click inside the box to remove the filler text.
4. **Type your text** or copy and paste it from a text document open on your computer. If the box already has placeholder text in it, the text will automatically be removed when you begin typing.
5. **How to make text fit in a text box:** If your text does not fit in a text box, the site will ask you to fix this issue by choosing one of the following options:
   - Manually correct the text (e.g., reduce font size, delete part of the copy, change the style or adjust the leading) to fit in the text box.
   - Automatically lengthen the text box (if space is available) to accommodate the text.
   - Automatically create additional text box(es) to the right of the original text box (if space is available) and flow the extra text into the box(es).

The **Font** Control Palette is where you can change the font attributes of the entire text box, or just a highlighted section within the text box.

**FYI: FONT ATTRIBUTES**

When you first enter text, it will default to the style you assigned in Styles & Settings. You can either keep it as the default style, or you can manually change one or more of these attributes:

- **Style:** Changing the Style attribute will change the entire text box to match the font, size, color and all other attributes of the selected style.
- **Font:** Changing the Font attribute will change the font of the text, but will retain the original size, color, and other attributes of the original text.
- **Font Style:** You can change the font style to make the selected text bold, italic, underlined, or add a drop cap. Clicking these icons will toggle the attribute on and off.
- **Size:** Changing the Size attribute will make the text bigger or smaller.
The **Color & Effects** control palette lets you change several visual attributes of the text.

**HOW TO: TEXT FORMATTING**

- **How to apply color to text**: Highlight the text on the page and then select a color:
  - Select one of the Lifetouch pre-defined colors.
  - *Select any color in the color palette by clicking on the shade that you want. Use the arrow on color bar to change color.
  - *If you have a specific color, you can enter in the RGB value.
  - *Use the eye dropper to select any color from a photo to apply as your text color.

- **How to make a text box transparent**: Select the text block, then click the Properties tab. In the Fill control palette, select the first color square under Lifetouch Colors for “None”.

- **How to add color to a text box**: Select the text block, then click the Properties tab. In the Fill control palette, select a color:
  - Select one of the Lifetouch pre-defined colors.
  - *Select any color in the color palette by clicking on the shade that you want. Use the arrow on color bar to change color.
  - *If you have a specific color, you can enter in the RGB value.
  - *Use the eye dropper to select any color from a photo to apply as your text box color.

- **How to review color choices**: Do not reply on the colors shown on your computer monitor. For pre-defined colors, order the Color Sampler from the Kit Material link to see actual printed samples.

- **How to find and replace words**: You can select “Find and Replace” in the Page Actions menu to find a specific word or phrase on the current page or double page spread. If desired, you can automatically replace each instance of the word or phrase with a new word or phrase.

*Tip: Click the sign in the upper right hand corner to add your color to the “My
The Spacing & Alignment control palette is where you can adjust several text attributes to achieve the typographic effect you want.

**FYI: SPACING & ALIGNMENT ATTRIBUTES**

- **Alignment**: The Alignment attribute determines the left-to-right placement of the text within the box. Text can be aligned to the left, centered, aligned to the right or justified. “Left alignment” or “Right alignment” means one side will be aligned and the other side will be ragged. “Centered” means all lines will align down the middle of the text box. “Justified” means the lines will be aligned on both the right and the left by spreading or compressing the text on each line.

- **Leading**: The Leading attribute determines the amount of space between each line of text. The larger the number, the more space there will be between lines.

- **Kerning**: The Kerning attribute determines the amount of space between specific letters. If kerning is “on,” the system will automatically adjust the kerning settings between pre-programmed letter pairs, so the spacing looks even to the reader. If kerning is set to “none,” all letters will have the exact same amount of space between them.

- **Tracking**: The Tracking attribute adjusts the amount of space between letters or words. If tracking is set to “none,” the words will be spaced according to the normal font settings. Increasing the number will increase the space between letters or words.

- **Margin**: The Margin attribute adjusts the amount of space between the text and the outside of the text box.
TEXT-WRAP

HOW TO: CREATE A TEXT WRAP

1. Create text, image and/or element boxes on your page and fill them with content. Select the text, image and/or element boxes you want to apply text wrap. Do this by either holding down the shift key and click on each element or by using your mouse to draw a box around the elements you want to select.

2. Under the Text section, go to “Text Wrap” and select the option to wrap text. (This feature also appears under the Element Actions drop-down).
   - On the left navigation, under Text Wrap, choose if you want the style to be Square or contour (in order to see this, just have your text box selected).
     - Square: This option will allow the text wrap up to the box around the image.
     - Contour: This option can be used on images that have a transparent background. The text will wrap up to the actual area of the image where there is no background.
   - Adjust the padding between the image and the text. This is measured in pixels.

SPECIAL CHARACTERS

The Special Characters control palette makes it easy to add unique text characters. Just place your cursor in the spot you would like the special character to be located, and then click the desired character from the list in the control palette.
The **Add Elements** icon is where you can create new elements and bring visual interest to your page. The element options are grouped into four categories:

- **Image Elements** are boxes and other shapes that can contain images.
- **Text Elements** are boxes that can contain text.
- **Shapes & Lines** are elements that can add visual interest to the page (but can’t contain images or text).
- **Text on Path** allows you to be creative with displaying text on the page.
- **Snip-Its** are a group of elements that allow for additional content on a page. Use them as designed or ungroup them to add your own customization.

**HOW TO: ADD ELEMENTS**

1. Go to the page you want to work on.
2. Click the Add Elements icon in the left column if it isn’t already open.
3. Identify the element you want by viewing the options in the Image Elements, Text Elements, and Shapes & Lines groupings.
4. Add the selected element to the page through one of two methods:
   - Click the element, then click the page and drag the cursor to define the size of the element.
   - **Drag and drop** your selected element onto the page. Then, adjust the size by dragging the corners of the element box.
5. Repeat these steps until you have finished adding elements.
6. Save the page to complete the process.
ADD ELEMENTS

HOW TO: ADD A SNIP-IT
1. Under Build > Add Element, select “Add Snip-Its.”
2. Find either a Lifetouch or Custom Snip-It.
3. Click the Snip-It and drag it on the page.

To build a custom Snip-It:
1. Select the elements you want in the Snip-It.
2. Under Element Actions, select “Save as Custom Snip-It.”
3. Portrait image boxes and portrait text boxes may not be saved as a custom Snip-It.

HOW TO: SWAP CONTENT
When an image or text element is selected, a swap icon displays. Click swap icon, hold down and drag to a different image/text box to swap the content. Photo properties (e.g., sepia, faded edges) move with the photos. Text takes on properties of new box.
HOW TO: CREATE TEXT-ON-A-PATH

1. Under **Build > Add Element** go to the “Add Text-on-A-Path Element” section. Select a text-on-a-path element shape. Click in the workspace and place the shape on the page. Double click the shape to insert text.

2. Enter the text and make adjustments to the font properties. Indicate if you want the text above the line or below the line.

3. Hold down the “Alt” key and double click the shape to alter the points of the shape.
The **Properties** icon is where you can apply image effects, change shapes, fill shapes, apply line borders to elements and adjust the size and position of placed elements. The Image Effects control palette is only available when you have an image selected on your page.

**IMAGE EFFECTS**

The **Image Effects** control palette enables you to enhance and manipulate your photos and other images.

**FYI: IMAGE EFFECTS**

- **Color**: Lets you change the image from full color to sepia tone or black & white.
- **Ghosting**: Adjusts the brightness of the image in 10% increments.
- **Fade**: Allows you to apply a light, medium or heavy fade to the edges of the photo.
- **Resize**: Adjusts the size of the image within the image element between 1% and 200% by moving the slider bar or typing a percentage directly into the Resize box.
- **Reposition**: Lets you drag the image to the desired position within the image box.
- **Rotate**: Changes the rotation of the image within the element box by typing a specific rotation in the box, or rotating in 90-degree increments (clockwise or counter-clockwise).
- **Flip**: Mirrors the image vertically (top to bottom) or horizontally (left to right).

The **Shape** control palette allows you to change the shape of your selected object by clicking a different shape within the palette.
The **Fill** control palette lets you fill any element with color. You can also adjust the tint if you don’t want the color to be solid.

**FYI: FILL**

- **How to add color:** Select the element, then click the Properties tab. In the Fill control palette, select a color:
  - Select one of the Lifetouch pre-defined colors.
  - *Select any color in the color palette by clicking on the shade that you want. Use the arrow on color bar to change color.*
  - *If you have a specific color, you can enter in the RGB value.*
  - *Use the eye dropper to select any color from a photo to apply as your fill color.*
- **Tip:** Click the sign in the upper right hand corner to add your color to the “My Color” library to use again.

The **Transparency** control palette lets you set the opacity of text, images, fill, shape, shape borders and backgrounds.
The **Border** control palette allows you to add a border to an element, and give it specific attributes.

### FYI: BORDER ATTRIBUTES

- **Size:** The point size for your border can be 1, 2, 3, 4, 5, 6, 9, 13, or 17.
- **Color:** The border can be any color within the color palette.
  - Select one of the Lifetouch pre-defined colors.
  - *Select any color in the color palette by clicking on the shade that you want. Use the arrow on color bar to change color.*
  - *If you have a specific color, you can enter in the RGB value.*
  - *Use the eye dropper to select any color from a photo to apply as your border color.*
- **Style:** The style of the border can be solid, dashed, or dotted.
- **Tint:** The tint of the color can be adjusted if you don’t want the border to be 100% of the color.

![](image.png)
The Drop Shadow control palette is where you can add a drop shadow to a selected element. Just click “Shadow” and adjust the drop shadow attributes. Shadows are only allowed on text when the text box is not filled. As soon as you add a fill to the text box, the shadow moves from the text itself to the box.

**FYI: DROP SHADOW ATTRIBUTES**

- **Color:** The drop shadow can be any color within the color palette.
  - Select one of the Lifetouch pre-defined colors.
  - *Select any color in the color palette by clicking on the shade that you want. Use the arrow on color bar to change color.
  - *If you have a specific color, you can enter in the RGB value.
  - *Use the eye dropper to select any color from a photo to apply as your drop shadow color.

*Tip:* Click the sign in the upper right hand corner to add your color to the “My Color”

- **Tint:** If you do not want the drop shadow to be 100% of the color, you can type in a tint value less than 100% or use the slider bar.

- **Position:** Indicate the position of the drop shadow by dragging the black square to the desired location. As you are moving it, you will see a preview of where the drop shadow will be placed.

The Size & Position control palette is where you can adjust the size, position, rotation and other attributes of the selected element.
The YB Parking Lot displays what is left over from the change template action:
• Drag & drop elements from the parking lot to page
• Drag & drop image, text, shape and text on a path elements from the page into Parking Lot
• Items will remain in Parking Lot until you leave the page
SALES TRACKER
Sales Tracker can be used to monitor and record yearbook sales. If your school is using YBPay, Lifetouch's online ordering site, the online orders will automatically appear in Sales Tracker.

Sales Tracker lets you:
• Set-Up/Edit Pricing
• Enter/track check and cash yearbook orders
• Submit Final Quantity

SET-UP/EDIT PRICING
• Displays all Lifetouch yearbook offerings indicated on the Lifetouch contract
• Indicate a price for each item by clicking the “Edit Pricing” button
• To offer different prices during different times of the year or for particular grades, set up pricing tiers in the Edit Pricing screen
• Add and track school related, non-Lifetouch offerings by clicking “Add School Related Items.” These items should not be items that Lifetouch needs to produce or ship. Examples of items to add include love lines, fundraising items, etc.
• Create packages by clicking “Add Package” next to the Package section
  – A yearbook must be part of every package
  – Once a package is live on the ordering site it cannot be edited, but it can be deactivated
  – Up to five packages can be active at one time
• Create advertisement options by clicking “Add Advertisement” next to the Advertisement section
• Indicate if consumers have the option to donate money for additional yearbooks
SALES TRACKER & FINAL SUBMISSION

SALES TRACKER

YBPay
If your school is offering the YBPay online payment site:
• Select the grades you are selling the book to
• Select the items to display on the YBPay site
• Indicate when you want the consumer site to be activated and deactivated.
• Indicate if you want a message to display on your consumer site

Enter Orders
Monitor orders through Sales Tracker List:
• Read-only version of the Name List is populated with all orders from YBPay and records of students selected to flow into the yearbook
• Sort by column headers, see all options ordered and export data to Excel
• Adviser will see a new “Order Origin” column that identifies where the order came from. Values include:
  – YBPay-Online
  – YBPay-Check
  – Adviser (orders entered by adviser in the Sales Tracker)
• The Add/Edit Order tab allows you to add or find a person’s name quickly by entering only part of a name
• Enter/Edit the purchaser’s information
• If a package is selected, the site will recognize what items are part of that package and instantly check those items
• Click Save and Add Another to record more orders

You must use Sales Tracker if you have contracted for any of the following enhancements:
• My Yearbook Personalized Covers (be sure each person ordering this enhancement has an image in their record)
• Foil Names and Icons
• Name Plates
SALES TRACKER & FINAL SUBMISSION

SALES TRACKER

MERGE FUNCTIONS

• Merge YBPay orders with Lifetouch records:
  – This is REQUIRED for records that purchased MYPC through YBPay.
  – Merging will also let you get a distribution list you can sort by teacher
• Auto-merge is available for:
  – Two records with identical spellings
  – Data in both records is empty or data in one record is populated and the other record is empty
• Manual Merge is available for names that are not identical. Drag one name on top of another name to merge the records. This is only available if at least one of the records does not have order information.

If records were manually added before Lifetouch uploads portrait names, check the list for duplicates. If duplicates appear, you can:
1. Merge the records
2. Delete the manually entered/imported duplicate records
3. Only complete information for one of the records
SALES TRACKER & FINAL SUBMISSION

FINAL QUANTITY SUBMISSION

FINAL QUANTITY SUBMISSION SCREEN

Submitting your final order quantity for yearbooks and enhancements is a required step in the yearbook process. This lets Lifetouch how many yearbooks and enhancements to produce for your order.

Take note of the following Items on this screen:
1. Your final yearbook quantity due date
2. Orders from Sales Tracker populates in this column
3. IMPORTANT: You may add additional quantities of yearbooks and other contracted enhancements to your order using this column
4. Your total order for yearbooks and enhancements
5. Your expected order arrival date based on the contracted final quantity and page deadline

PERSONALIZATION LIST DUE

WebEase schools that offer personalization (My Yearbook Personalized Covers or Foil Names and Icons) must submit the enhancement name list with the final order quantity submission. For school using the Volumes program, the final quantity submission date is earlier than the personalized enhancement name list due date.
To view pages properly, you may need to adjust the default settings in your Web browser. First, you should make sure you are using a supported browser.

**HOW TO: CONFIRM YOUR BROWSER MEETS SITE REQUIREMENTS**
- If you are using Internet Explorer, open a browser window and select “About Internet Explorer” in the Help menu. If it tells you that you are using a version older than 8.0, you will need to download the latest version from the Microsoft® website.

**HOW TO: ADJUST YOUR SETTINGS - CACHE**
To view pages properly, you may need to adjust the default settings in your browser.

**INTERNET EXPLORER – WINDOWS**
- With your browser window open, go to Help > About Internet Explorer and confirm the version number is 8, 9, 10 or 11.
- Go to Tools > Internet Options. From the Browser History area, click Settings.
- Click OK on the Internet Options dialog box. In the “Temporary Internet Files and History Settings” dialog box, look at the top for the setting to Check for newer versions of stored pages, and then select “Every time I visit the webpage.”
- Click OK on the “Temporary Internet Files and History Settings” and OK again to close the Internet Option.
ADJUSTING COMPUTER SETTINGS – COOKIES

Each time you sign into your account, a temporary cookie (small text file) is stored on your computer. When you sign out or close the program, the cookie is removed. If you keep returning to the Sign In screen, even after you’ve entered the correct user information, you might need to reset your browser to allow cookies.

HOW TO: ALLOW COOKIES PC

**Internet Explorer**
1. Go to Tools and select Internet Options.
2. Go to the Privacy Tab and set the Internet Zone to “Medium” or “Low.”
3. Click “Advanced” and select both “Override automatic cookie handling” and “Always allow session cookies.”
4. Click “OK” to close the Advanced Privacy Settings window.
5. Click “OK” again to close the Internet Options window.

**Firefox on a PC**
1. Go to Tools and select Options.
2. Go to Privacy.
3. Find Cookies and select “Accept cookies from sites.”
4. Click “OK” to save changes.
HOW TO: ALLOW COOKIES MAC

Firefox on a Mac
1. Go to the Firefox menu and select “Preferences.”
2. Select the Privacy tab.
3. Go to Cookies and select “Accept cookies from sites.”
4. Click “OK” to save changes.

Safari on the Mac
1. Select “Preferences” from the Safari menu.
2. Click the Security icon near the top of the window.
3. Go to Accept Cookies and make sure either the “Always,” or “Only from sites you navigate to” option is selected.
MONITOR RESOLUTION
The site is designed to work best at a resolution of 1280 x 1024, but it will also work at a resolution of 1024 x 768.

HOW TO: SET MONITOR RESOLUTION
PC
1. Go to Start and select “Settings.”
2. Go to Control Panel and double-click the blue Display icon.
3. Go to the Display Properties window, and then the Settings tab.
4. From Screen Area, move the slide bar to the right toward the “More” label, until it is set at either 1024 x 768 or 1280 x 1024.
5. Click “Advanced” and select the “General tab.”
6. From the Font Size area, select Small Fonts from the drop-down list.
7. Click “OK” to exit each window.

NOTE: You may have to click “OK” a few times while Windows resets your monitor settings.

MAC
1. Open the Apple menu (click the “apple” logo in the upper left corner of the screen).
2. Select “Systems Preferences.”
3. Select the Displays icon.
4. Select either the 1024 x 768 setting or the 1280 x 1024 setting and your monitor will automatically adjust to the new setting.
FYI: TIPS TO PREVENT PROBLEMS

- **Anti-Spyware:** For the best experience with our website we recommend that you install Anti-Spyware software on your computer. Anti-Spyware is security technology that helps protect Windows users from spyware and other potentially unwanted software. You can get anti-spyware software at [www.microsoft.com](http://www.microsoft.com).

- **Pop-ups:** Lifetouch uses Pop-ups throughout the websites. If you use Pop-up blocker software, you must configure it to accept the following domain: [http://onlineyearbooks.lifetouch.com](http://onlineyearbooks.lifetouch.com).

- **Firewalls:** If you use a firewall, you must configure it to accept the following domain: [http://onlineyearbooks.lifetouch.com](http://onlineyearbooks.lifetouch.com). Contact your Network Administrator to verify the firewall is not drastically slowing down Internet connections. If your connections are too slow, you could time out during certain requests, like uploading photos. Also, verify that the configuration will let you access and receive information from Lifetouch websites.

- **Spam Filters:** To ensure you receive important emails from Lifetouch, add lifetouch.com to your approved email list.

- **Printing Pages:** Change margins if you have trouble fitting images on a page when printing. Go to File > Page Set-Up and adjust the margins accordingly (e.g., 0.5” on each side).

FYI: GOOD PRACTICES

To eliminate some common issues when accessing the site, you should:

- **Close all unnecessary applications,** especially applications that require a lot of resources such as an Internet radio.

- **Save your work often,** approximately every 15 minutes.

- **Don’t wait until the last deadline** to upload all images, create pages and view proofs. The weeks before the last deadline is a busy time for Lifetouch servers, causing the server response time to be slower than during off-peak times.
HOW TO: TROUBLESHOOT A TECHNICAL PROBLEM

- Determine where the problem stems from (computer hardware, configuration or from the school’s network).
- If a process worked before, but doesn’t now, check whether anything has changed on the computer or school’s network. Has a new application been installed, or changes made to the computer’s network or firewall? You might need to contact your System Administrator for information.
- Try a different computer and see if the problem is replicated. If not, the problem is most likely isolated to the one computer. Contact your Network Administrator for help.
- Check the bandwidth on your network by using an Internet search engine to search for “connection speed.” (These sites are trying to get you to buy a tool, but often they will give you one free test of your Internet connection.) DSL connections typically have a bandwidth of 768 kbps and cable connections are typically 1.5 mbps.
- Upload images, create pages and view proofs intermittently, rather than all at once right before the deadline. If possible, work on the yearbook when there is low activity on the school’s network.
- Contact your ISP if you are getting dropped from the Web site, your connection speed is slow or you have determined (to the best of your ability) it is not an issue related to your computers or network. It will be most helpful if you can provide them with the following information:
  - What time the error/issue occurred.
  - The exact error message, if you received one. Take a screen shot of the error message so you have it for reference or can email it if requested.
- Contact your Lifetouch Customer Care representative if your ISP is unable to troubleshoot your issue. Provide the following information:
  - What time the error/issue occurred.
  - Which screen you were working on and/or the exact error message (to print the error message: click the “Print Screen” button on the upper right hand side of your keyboard, so you have it for reference or can email it if requested.)
  - Indicate whether multiple users experience the issue.
Account Executive: Your Lifetouch contact for questions or assistance.

Activity Photo: Any photo that is not a portrait. Activity photos include un-posed (candid) subjects or posed subjects such as club, team or class photos.

Adobe® Reader®: The software program that the site uses to view PDF proofs of yearbook pages.

Adviser: Person (usually a teacher or school representative) who directs the yearbook process at the school from start to finish.

Alignment: Bringing letters of a line of type together into exact position—either left justified, centered, right justified, justified or full justified.

Approve: To accept the page you have submitted to Lifetouch, or to accept the changes that Lifetouch made to your page, according to your special instructions.

Artwork: Photographs, drawings, hand lettering and line art, which is prepared for illustration on a yearbook page.

Aqueous Coating: A glossy, environmentally safe coating on soft cover yearbooks.

Background: Design, pattern or image used to fill and enhance the yearbook page design.

Base Color: The first color used as a background on which other colors are applied.

Candid Photo: An activity photo in which the subjects are informal, spontaneous and not posing.

Caption: Text located near a photo that explains what is happening in the photo.

Clip Art: Graphical artwork used to enhance the yearbook.

CMYK (Cyan, Magenta, Yellow, and Black): The four colors used in the printing process.

Credit Line (or Byline): A statement giving the name of the person responsible for a picture or copy.

Crop: To eliminate (opaque, mask, cut or trim) portions of an illustration or photo to fit a specific area, or to capture only a portion of the photo on a yearbook page.

Custom Template: Original page templates created by a school.

DPI (Dots Per Inch): Used to measure resolution for scanning and printing. Generally, more dots per inch means a higher resolution, a greater amount of visible detail in the image and a larger file size.

Deadline: Date by which pages, cover designs or other production-related materials are due at the publishing plant.

Digital Image: A photo composed of pixels (captured on a digital camera, scanned or created from scratch with image-creation software).

Double-Page Spread: A spread with cross-gutter elements.

Download: To take photos from a digital camera and transfer them to a computer. Can also mean transferring files from an email or from a website to your own computer.

Endsheets: Sheet of heavy text stock paper that is used to attach the inside pages of a hard cover yearbook to the cover. One half of the endsheet is adhered to the inside cover, while the other half creates a page in the book.

Enlargement: A reproduction larger in size than the original.

EPS (Encapsulated PostScript): An Adobe graphic file format. If graphics do not export or import well as a TIFF (Tagged Image File Format), EPS is another option. EPS translates graphics and text into a code that the printer can read and print.

Export: A process to create a file in a format that is compatible with other applications. This option can usually be found under the File menu in most graphics software applications.

Finish: The surface property of a sheet of paper, such as gloss or matte.

Flowing: Arranging the portraits on the page. Once you have finished proofing your portraits and you have selected enough pages for each of your sort values, you will be asked to flow your portraits onto your portrait pages.

Flush: Usually refers to typeset copy that is even with the margin or photo box.

Flush Left: Refers to typeset copy that is straight on the left edge of the printing or text area.

Flush Right: Refers to typeset copy that is straight on the right edge of the printing or text area.
GLOSSARY

**Foil Imprinting:** Tissue-thin material faced with metal or pigment used in book stamping with a stamping die. Foil imprinting has a high gloss, metallic shine. Foil imprinting is available in a variety of colors.

**Fold-Out:** A page that exceeds the dimensions of a single page. It is folded to page size and included in the book, sometimes bound in and sometimes tipped (pasted) in. Available in Volumes only.

**Folio:** Small graphic elements designed to be placed near the page number.

**Font:** An assortment of type of one size and face containing all of the characters needed for ordinary composition. The term refers generically to letter styles.

**Four-Color Process:** A reproduction of color made by means of photographic separations. Four-color printing uses cyan (blue), magenta (red), yellow and black inks, each requiring its own plate. This is the means of four-color reproduction in printing.

**Full-Color:** Another term for four-color process. A reproduction of color made by means of photographic separations. Four-color printing uses cyan (blue), magenta (red), yellow and black inks, each requiring its own plate.

**Ghosting:** Adjusting the brightness of an image.

**Gutter:** Short for Gutter Margin – the margin in the middle of a double-page spread.

**HTML (Hypertext Markup Language):** A programming language for websites that can incorporate text, graphics, sound, video and hyperlinks.

**Headline:** Words set at the head of a page to introduce or categorize.

**Headsize:** The size of the portrait box that the portrait images will be placed in.

**Hot Foil:** Tissue-thin material faced with metal or pigment used in book stamping with a stamping die. Hot foil has a high gloss, metallic shine. Hot Foil Namestamping is available in a variety of colors.

**Image:** Any picture, clip art or scanned text that can be placed in a photo box.

**Italic:** Style of letters that slope forward, often used for words requiring emphasis.

**JPEG (Joint Photographic Experts Group):** A bitmap file format that uses compression to decrease image file space.

**Justify:** To set type or prepare text composition to a specified width or measure so that the left and/or right-hand margins of the printed matter will be aligned. Justification may be accomplished by adjusting the spacing between words and characters to fill the measure with each full line of type.

**Kerning:** Adjusts the preset space between pairs of letters. Kerning takes away some of the space between letters to create a more visually pleasant configuration. Kerning is strictly proportional so that the space gets bigger or smaller at the same rate as the characters.

**LPI (Lines Per Inch):** A unit of measurement used to describe resolution by specifying the number of lines that are printed in an inch. The higher the number of lines, the higher the print quality.

**Ladder Diagram:** A planning tool used to plan the contents of each page of the yearbook—an important first step in designing the yearbook.

**Leading:** The space between lines. You can change leading if you want to increase or decrease the space between lines of text.

**Login Information:** The unique and secure information that each user must provide in order to gain access to the site, including the job number, a user name and a password.

**Low Resolution:** Low-resolution files require less memory than high resolution files, and are only acceptable for monitor display. Resolution is calculated in “dots per inch” (dpi). A standard low-resolution scan is 72 dpi or 96 dpi. On this site, images appear in low-resolution on screen, but will be replaced with the high-resolution image when printed in the final yearbook.

**Matte Finish:** Dull paper finish without gloss or luster.

**Montage Page:** Created by pasting overlapping photos onto a Layout Board—a fun way to feature a lot of student photos on a yearbook page.

**Natural Spread:** Two facing pages in a book that are printed together within a flat. Because they are printed at the same time, photos that extend across the gutter of the yearbook should be placed within a natural spread. In Smythe sewn books, each 16-page signature of the book will include a natural spread (e.g., pages 8 and 9 are a natural spread).
**PDF (Portable Document Format):** An Adobe® electronic document format that allows the distribution and display of a document as originally designed and formatted without having the software application or fonts loaded on the viewing computer.

**PPI (Pixels Per Inch):** A unit of measurement describing the amount of data contained within a bitmapped image.

**Pica:** A printer’s unit of measurement for length of lines and depth of type pages. Six picas equals one inch.

**Pixel:** The smallest units of data in a digital image (the little squares you see when you zoom in on a photo). Together, pixels constitute a digital image. A pixel's code contains information related to color and placement within the larger image.

**Point:** A printer’s unit of measurement used principally for designing type size. There are 12 points to a pica and 72 points to an inch.

**Portrait:** An individual photo of a student or staff member issued in the creation of the portrait pages of the yearbook.

**Proofs:** Files that represent how a page will look in the final book. On this site, page proofs are generated electronically and are viewable with Adobe® Reader®.

**RGB (Red, Green, Blue):** The color scheme used to display color images on computer monitors.

**Refresh:** An action that re-loads your current web page within the browser window. You should frequently click the “Refresh” button located at the top of your screen to update your page. This is helpful in a situation where someone else might be working on the same section of the book.

**Resolution:** The number of pixels (picture elements) per unit of linear measurement (inch) on a computer monitor, or the number of dots per inch in a digital picture.

**Smythe Sewing:** A book-binding process in which 16-page signatures are folded and trimmed to create a 16-page section. These 16-page sections are stitched together and inserted into the cover.

**Snip-It:** Group of elements that allow for additional content on a page. Use them as designed or ungroup them to add your own customization.

**Sort Value:** When student and teacher portraits are uploaded to the site they are placed in sort values. Portraits are separated into different sort values according to grade, homeroom or teacher ID.

**Submit:** To send your saved work and any special instructions to Lifetouch.

**Supplement:** An additional insert to capture year-end activities that occur after the early submission deadline. Supplements may be stitched in or include an adhesive strip so that the students can insert it into books after delivery.

**Thumbnail:** A small preview of a yearbook page, which can be found in the Ladder Diagram and throughout the site. Clicking on the thumbnail will open up the page in the corresponding “builder.”

**TIFF (Tagged Image File Format):** TIFF files can be color or grayscale. Their resolution or dpi determines the quality of the image. When exporting images for use in QuarkXPress® or InDesign®, choose this format first. If it does not work well, the EPS format should be fine. If using graphics like line art, an EPS file format is recommended instead of TIFF.

**Tint:** A screened-back version of a pure color measured in a percentage amount. Full color is 100%, and a tint is a version of that color that is less than 100%.

**Tracking:** Determines the amount of space between letters and words. Tracking adjusts the relative space between characters so that it gets slightly tighter at large sizes and slightly looser at small sizes. You can choose to increase or decrease the tracking in increments of five points.

**Trim Size:** The final size of yearbook page.

**Upload:** Transferring information from a personal computer to Lifetouch.

**Zoom: A Year in the Life (Volumes)/A Year in Review (WebEase):** A 16-page, full color year-in-review insert that can be stitched or taped in the yearbook. It features the year’s biggest news stories, sports achievements and hottest entertainment buzz.
## INDEX

### A
- Add Elements to Pages ........................................... 73-74
- Add Name to Portrait Library .................................. 57
- Add Names to Index .............................................. 59
- Add Sort ................................................................... 56
- Apply Borders and Backgrounds ............................. 23, 69
- Apply Templates .................................................. 37-38, 64-65
- Approve Pages ...................................................... 38
- Assign Color Pages .............................................. 21
- Assign Deadlines .................................................. 21
- Assign Spot Color .................................................. 22
- Assign Sorts to Pages .......................................... 65

### B
- Body Copy Styles .................................................. 24-26
- Book Settings ..................................................... 21-29
- Borders & Backgrounds - Defaults ......................... 23, 69
- Borders for Page Elements .................................. 77
- Browser Requirements .......................................... 85
- Browser Setup ...................................................... 7
- Build Pages ....................................................... 61-77

### C
- Cache: Adjust your Settings .................................. 85-86
- Change a Page Template ....................................... 64
- Change Portrait Images ........................................ 50, 66
- Color & Deadline Assignment ............................... 21
- Color & Effects for Text ......................................... 71
- Community Upload .............................................. 11-12, 49
- Contact Information ............................................. 5
- Cookies: Allow on a Mac ...................................... 87
- Cookies: Allow on a PC ......................................... 86
- Copy Page .......................................................... 41
- Copy Portrait ..................................................... 53, 66
- Cover & Endsheets - Volumes ............................... 34
- Cover & Endsheets - WebEase ............................... 32-33
- Cover Artwork .................................................... 34-36
- Cover Book .......................................................... 33
- Cover Proofs ....................................................... 34, 36
- Create a Custom Style .......................................... 26
- Custom Templates ................................................ 58, 66
- Custom Dictionary ............................................... 28
- Customize your Site ............................................. 8, 19, 29

### D
- Drop Cap for Text ................................................. 70
- Drop Shadow for Page Elements ............................ 77

### E
- Edit Portrait Pages ............................................... 66
- Element Actions Menu ......................................... 63
- Export Portraits from Portrait Library ..................... 56

### F
- Facebook Preview ................................................ 13-16
- FAQ's ................................................................ 11
- Fill Page Elements .............................................. 75
- Flow Portraits .................................................... 53-55
- Font .................................................................... 71
- Fonts - Select your Defaults .................................. 24

### G
- Glossary .............................................................. 91-93
- Good Practices .................................................... 89

### H
- Home ................................................................. 9-18

### I
- Icons .................................................................. 61
- Image Details ...................................................... 47, 68
- Image Effects ....................................................... 74
- Image Libraries .................................................... 44-46
- Image Library - Create new folder ......................... 48
- Image Library - Delete folder ................................ 48
- Image Library - Rename folder ............................. 48
- Image Management ............................................. 43
- Image Usage ....................................................... 49
- Images - Placing on a page ................................. 67-68
- Import from previous year .................................... 7, 29
- Import to Custom Dictionary ................................. 28
- Index Editor ......................................................... 60
- Index Editor ......................................................... 60
- Index – Enter Names in Image Library ..................... 47
- Insert Text .......................................................... 69

### K
- Kerning .............................................................. 27, 72

### L
- Ladder ............................................................... 37-38
- Libraries ............................................................ 43-60
- Login ................................................................. 6
INDEX

M
Mail CD's and Prints to Lifetouch ........................................ 45
Manage Users .................................................................. 19
Master Pages .................................................................... 39
Monitor Resolution ....................................................... 88
Move a Page .................................................................... 41
Move a Portrait ............................................................. 53
My Profile ........................................................................ 10
My Tasks .......................................................................... 10

O
Organize Pages .................................................................. 41
Overall Site Navigation .................................................. 8

P
Page Actions Menu .......................................................... 62-63
Page Control Palettes .................................................... 61
Page Details ...................................................................... 67
Paging Lot ......................................................................... 78
Place Images on Page ....................................................... 67
Placed Images ................................................................... 68
Plan .................................................................................. 31-42
Portrait Default Settings ................................................... 23
Portrait Details ................................................................. 51
Portrait Flow Guidelines ................................................... 53-55
Portrait Library ............................................................... 50-51
Portrait Page Wizard ....................................................... 52
Proof Covers ...................................................................... 36
Proof Pages ......................................................................... 38
Properties .......................................................................... 76

R
Resize and Move Images ................................................... 68
Re-sort Portraits ............................................................. 57
Resources .......................................................................... 85-93

S
Sales Tracker ...................................................................... 81-84
Search Image Library ....................................................... 49
Search Portraits ............................................................... 56
Security Statement ........................................................... 6
Select a Page Template .................................................... 64
Shapes .............................................................................. 76
Shortcuts, Keyboard .......................................................... 79
Shortcuts, Links ................................................................. 13
Site Preferences ............................................................... 29
Size & Position of Page Elements ...................................... 75
Snip-Its ............................................................................ 58, 74
Sort .................................................................................... 56
Sort Assignments ............................................................. 65
Spacing & Alignment of Text ............................................. 72
Special Characters ........................................................... 72
Spot Color ......................................................................... 22
Student Frequency Report ................................................. 11
Styles .............................................................................. 25-27
Submit Final Quantity ....................................................... 83
Submit Pages ..................................................................... 38
Supplements ..................................................................... 40
Swap a Page ...................................................................... 41
Swap Content ..................................................................... 74
System Check ..................................................................... 6
System Requirements ....................................................... 5

T
Template Library ................................................................ 58
Text Formatting ............................................................... 69-70
Troubleshooting .............................................................. 85-90
Typography Recommendations ......................................... 26

U
Upload Images ................................................................... 43-45

V
Video Tutorials .................................................................. 11
View Book ........................................................................... 31
View Menus ....................................................................... 63
View Page Proofs .............................................................. 40

Y
Yearbook Parking Lot ....................................................... 78
Yearbook Deadlines .......................................................... 9
Yearbook Page Status Report ............................................. 12
Yearbook Preview ............................................................. 40